Easy Data Transform v1.8.2
for Mac

© 2020 Oryx Digital Ltd, all rights reserved




Table of Contents

1. Getting started 5
1.1 INErOAUCLION ... ccccrececeetrrecc e sneneeereeese s s s ssnnneseeesessssssnnnesenssesessssnsnnnenesesensssssnnnennns 6
1.2 SYStEM FrEQUIrEMENLS ....ceeeeeeiiiiiiiiiiinnneeeiiiiieiiiinnneettiiessssssssnnsssssssessssssssnsssssssssssssssnsnsssssssssns 6
13 QUICK SEArt SUIHE ...euereeeeeeeeeieeeciirreneeeeeteeecccsssnnneeeeesecsssssssnssseseesessssssnnssssessesssssssnsssssssesesssnsans 6

2. Reference 16
2.1 USEr INEEIACE ...t cccceeceertresec e sssneneeeeteeseessssnnnesesssesessssssnnsesasesessssssnnnnesesaesesssnnnnn 17

2.1.1 1Y/ 1T VIV 0T o 1Y U 17
2.1.2 [0 o T o SRR 17
2.1.3 (61T o) (=T o - o L= PP PP PP PPPPPPPPPNN 17
2.14 24 T=d 0 A o - o IR 18
2.1.5 Preferences WINAOW ...ttt e e e e e errae e e e e e e e e neraaeeeas 18
2.2 T o 11 | O ON 19
2.2.1 [ aY U o - - SRR 19
23 TraNSFOIMS ...ueeeeeeeeeriicccccrreeneeeetriecesssssneeeeeeesessssssnnneesessesessssssnnneesassessssssnnnsesansesessssssnnnennes 21
2.3.1 TransformM data ...oeeeceieeecccee e e e e e e eeeanns 21
2.3.2 L0 TP PPPPPPPPRE 21
2.3.3 1 o o SRR 22
234 (1o o 1SRRI 22
235 COMPATE COIS oiiiiiieeieeee ettt e s e e e st e e e s saba e e e s sabbeeesebraeeesnnraeeeens 22
2.3.6 (0o g Tor- | A 6o U UPURRRY 23
2.3.7 (@0 g [or= Ll 2 (o 1V UUPPPN 24
2.3.8 (60 o)V 6o L3OO UPURRRRRORN 25
2.3.9 {61 1 U 1o | PP PPPPPPPPPPPPRE 25
2.3.10 L0 o 3T PP PPPPPPPPPPRE 26
2.3.11 (D1 (=3 o] 1 o - | A PO PPPPPPPPPRRRRPPPPPPR 27
2.3.12 DT LUT o 1T UUER 28
2.3.13 4 o= o PP PPPTPPRRPPPPPNt 29
2.3.14 1 SRR 29
2.3.15 1 1< PR 30
2.3.16 LG 1= P 31
2.3.17 SRR 33
2.3.18 NS Bt e, 34
2.3.19 LN =T o oY - | U 34
2.3.20 L) =] ] =T ot AP P PPPTTPPRRRRPPPPPNt 40
2.3.21 JAVASCIIPE oo, 40
2.3.22 o 1 SRR 43
2.3.23 [ o] U T o PRSPPSO 45
2.3.24 NEW COl ettt e e e et e e e et e e e e eateeeesaareeeeesassaeeeeenneeeeeannnanaaans 48

Easy Data Transform © 2020 Oryx Digital Ltd



Table of Contents

2.3.25 NUM FOrmat oo, 48
2.3.26 2T PSSR 49
2.3.27 V7o ] PRSP SURRRSIP 50
2.3.28 REMOVE COIS ..eviiiiieieee ettt e et e e e e e e e et r e e e e e e e seseaanraaeeeaaeeeeennnsraneeeas 51
2.3.29 20T T 1o LI O] SRR 51
2.3.30 RENAME COIS .euviiiiieiie ettt ettt e e e et e e e e e e e et ar b e e e e e e e ee s aasraeeeeeeeesennnsraneeeas 51
2.3.31 20T o] o F=T o] LSRR 52
2.3.32 0= o] = Lol SO TRRRPPP 52
2.3.33 ROW NUM o, 53
2.3.34 Y- 1101 o SRR 54
2.3.35 Yo AR 54
2.3.36 Y o111 4 o1 PR 55
2.3.37 SPIIE ROWS eeiieiiiiiiteee ettt e e et e e e e e e e e e e bt aaeeeeeeeeesasasseaeeeeeeeaeansrsnaeaaaneaann 55
2.3.38 Y oL =T Lo PSSP 57
2.3.39 1] 7 [ P 58
2.3.40 1) = 1 ] J U UUUPN 60
2.3.41 1) - | 61
2.3.42 YU o3 ) (U SRR 62
2.3.43 K U o1 Lot AR 63
2.3.44 SUMIMIAIY et 64
2.3.45 o] 7 | IS UURRRRPPRPRRIOt 65
2.3.46 T AN S POSE e s 65
2.3.47 L 1 66
2.3.48 Y oY1 =T o Lol < TSRS 66
24 L0 11 11U N 67
24.1 (@ 1U1 o1V o -1 - U UPURRROY 67
2.5 File fFOrmats ... 69
2.5.1 (GRYY A (o 0 4= SRR 69
2.5.2 (el o o 1T | AU R 70
253 10 1\ (oY1 4= AR 70
2.5.4 [ I A1 o T o o - | SRS 71
2.5.5 MarkdoWn FOrMAL ....c..eeieiecceee e e e e e e e s e e e e e e aaaeeaeas 72
2.5.6 LYV o] 1 14T SR PRPN 73
2.5.7 (VLG 1o I (oo 4 T | AU SP 73
2.5.8 )41 | 0T o= | PSR 74
2.5.9 7N Y1 o] o010 = 1 SRR 76
2.6 [ T2 T L= RPN 77
2.7 {07 0] 4 T=Tot 4T 3 L3 77
2.8 =) N 79
29 [ F- 1 =N 79

Easy Data Transform © 2020 Oryx Digital Ltd



Table of Contents

2.10 NUMDEIS ..cieeiiiiittiineniinseenisssssenisssssnsssssasesssssssnsssssssnnssesssnsessssssnsssssssssensssssnssnssssnnens 80
211 Meta INfOrmMation .......cccciiiiiiiiiiinieiinieninernserese e sssss s sssssssasssssssssssssssssnnssnns 80
2.12 Column Variables .......ueiiiiieeiiiiieniiinneniinneiisssesnissesissssssenssssssssssssssssssssssssssssssnsssssssns 82
2.13 REBUIAr @XPIrESSIONS ..ceciiiiiiiiiiicnnnetiiiiieiiiisennneetiiiisiisssssnsssssssiessssssssnssssssssssssssnsasssssssssssssnnns 82
2.14 BAtCh PrOCESSING ...eeeeeeeeeiiieieirrrrsnneeeeeeneessssssnneeeeeeescssssssssassesssesessssssssssessesessssssnsnsasessesessssssnn 83
2.15 Command liN@ arGUMENTS .....ccccceeiiiiiveeiiiiisnnniiiissneiiisineniesssnenessssnsssssssssssssssssssssssssnsssssssns 86
2.16 Aransform files .....icvviiiiiiniiiiiniirinrr s s sae s ae e 86
2.17 Keyboard ShOTCULS ......c.ciieiiiiircceentiiecccnreeeneeetteesccssssnnneseessesessssssnnsenseesessssssnsnssssssesessssnnnn 87
3. Howdol? 90
3.1 Add a transform between existing items .......cccccvvveriiiineniiiiineniiinnneniseeseses 91
3.2 Add Or remove @ hEAUEr ......eeiiiiieiiiiiiiiiinierincner s sssssss s sssss s ssssssssessssnssens 91
3.3 Change @ CONNECLION ...cccceeiieeeiirreeceetteeeecccsrennneeetteeeeesssssnnseseeesessssssnnnessessessssssssnnsssssssesssssnnn 91
34 Change eNCOAING ...ccccceriiiiinniiiiiinniiiiineriisisneiissssnseiissssnsiessssnensssssnssssssssssssssssnssnssssansssssssns 91
3.5 (D10 [T o YU 1o F=1 - 13 =] /S 92
3.6 Find the difference between dates/datetimes .........ccccceevcererrereisnerrseeresseeresseesesseeeesnenens 94
3.7 Handle column name/order changes in INPULS ......cccceccerereerrercseeerereseesseessseeessesessesssneenes 95
3.8 Handle 1arge datasets .......cccccveeeeeieeeeeerrrssnneeeeeeescesssssnsneeeessesessssssssssessesessssssssssssessesessssssns 97
3.9 Input a fixed width format file ......ccccceviiiveiiiiiiviiiiirrirre e 97
3.10 IMErge datasets ....cccccceeeeiiiieiiiiinnnnetiiiiieiiiinnseeeiiiesiiinssnsssesiiiesssssssssssssssssesssssnsassssssssssssnnns 929
3.11 Move a .transform file ......eiveiiiiiiiiir s 104
3.12 Output nested JSON OF XIVIL ......ceeiiiiicnriiiissneniissssnenisssssnnnsssssssssssssssssssssssssnsssssnssssssssnssssss 104
3.13 OULPUL £0 EXCEI ..ceeerrreeneeeeeiieciirrsseneeeeeeeecesssnneeseeseesessssssssssssessessssssssssssessssessssssnnnsssessesens 105
3.14 Perform the same transforms on many files .......cccccciiviireiiiiiiceniiinnneninnnnenninnnennne. 106
4. Support 111
4.1 L0001 7= 1ot Y U] o' Yo o N 112
4.2 [1{=T o Yol - Y <111 -SSR PSP P PPPPRRN 112
4.3 Request an enhancement .........cciiiieeiiiiinnniiinineniiineeiiisesesiissesiessesssssssssssn 112
Index 113

Easy Data Transform © 2020 Oryx Digital Ltd



Getting started




Getting started

1 Getting started

1.1 Introduction

Easy Data Transform allows you to quickly transform table and list data into new and more
useful forms, without programming. The step-by-step visual transformation is quicker, more
interactive, more repeatable and less error prone than other approaches.

Please take a couple of minutes to read the Quick Start Guide.

1.2 System requirements
The suggested requirements for running this software are:

e Operating system: macOS 10.12 or later.
e Screen resolution: 1280x720 pixels or better.

If your operating system is more recent than the above check our website to find a
compatible version of Easy Data Transform.

You may be able to run the software satisfactorily on lower specification systems or more
operating systems, but we can't guarantee it. If in doubt, try running an unlicensed trial
version before you buy a license.

1.3  Quick start guide

This is a quick tour of some of Easy Data Transform's features. It should only take a couple
of minutes to complete.

Start Easy Data Transform. If the Free Trial window appears, click Continue free trial. If the

Getting Started window appears, click I have used it before! (or you will just end up back
on this page). You should now see the main window.

Easy Data Transform © 2020 Oryx Digital Ltd



Getting started

N Easy Data Transform +1.4.0 {free trial)
DBEEJA @ Q 3# & _rrwor
v Input

From File (0]

Froem Clipboard  (F)

Add data you want to transform by:
- dragging data files here; or
- clicking the 'From File' or 'From Clipboard® buttons

[ Email us questions/fesdback

Drag a data file you want to transform onto Easy Data Transform. Any sort of table or list
should be fine. For example a .csv file or an Excel .xIsx/.xIs file. XML, JSON and vCard formats
are also supported.
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N Easy Data Transform +1.4.0 {free trial)
DBEEOQ @ Q # & rhHwor
= Input testicsv @[5
Fremfie () . ' ' File: [UsersjandybyDeskiop/iest.csv
Froem Clipboard  (F) wateh file

z Transiarm Delimiter:  Aulomatic

€ 4

All ranstorms = Encoding:  Automatic
Case @ ’ lgnore; First O rowis) -
. + has header
i (7
Chap @ ¥ trim whitespace
Clane ® + simplify whitespace
o + ignare empty rows
Compare Cals L7} . . . Alias: test]
Concat Cols (}. Camment:
Copy Cols (&)
2 C||% & Show first 10 ows &
Count '®
@ . 7 testl.csv . title  firstrama  lastname  suffix  display name
= 23 esls » 64 rows 1 Mr Andrew  Adams Mr Andrew Adams
Date Format (7]
2 Mrs  Nikki Adams Mrs Nikki Adams
Dedups i)
3 Ms Rose Atwell Ms Rose Atwell
Extract &
i ':2-) 4 M Colin Ayar M Calin Ayar
Fiter O 5 Mrs  Michelle Slairg Mrs bichelie Blairg
Gathar {:I 8 M Siman [Blaire Mr Simon Blaire
F) ) 7 Mr  Albert Brown Mr Albert Brawn
ranrt & 8 Mz Cynthis  Brown Mrs Cynthia Brown
o) 9 Miss Jane Brawn Mrs Jane Brown
Javaseript (3) . 10 Mr David  Burgess Mr David Burgess
@

[ Email us questions/fesdback

Notice that the available transforms are shown in the Left pane and the selected dataset is
shown in the Right pane.

In the Right pane, you can check has header, depending on whether you want to treat the
first row of the dataset as a header.
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testl.csv @

KA
|

File: /Usersfandyb/Dropbox/testl.csv

Delimiter: Automatic

Encoding: Automatic

& &

lgnore:

simplify whitespace
ignore empty rows
watch file

Alias: test1

Comment;

22 cols x 64 rows

C [% V Show first 10 rows E

title first name last name suffix meal spe@

All the transforms available for a single dataset are now enabled in the Left pane. Hover
over the transforms to see tooltips explaining what they do. Click on the ? next to a
transform button for more details.

Ensure the input item is selected and click on the Case transform button to change the case
of your data.

Easy Data Transform © 2020 Oryx Digital Ltd
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‘soe Easy Data Transform vw1.4.0 (free trial)

DBEEO0QQAHE rumomr
v Input
From File (0]

Froem Clipboard  (F)

All ransforma

Casie
Chop &
Clane &

Compare Cols (7}

concatcols  (F)

Copy Cols @

Count @
® ' &

Date Format LA}

testl.csv

1} eods x 64 rows

Dedups i)
Extract I:Z)
Fill @
Eilter .:_r)
Gathar @

" .'?. .
ranr &
@

Javascript @ .
@

A Case transform item will now be added.

‘@ L ] Easy Data Transform ¥1.4.0 {free trial)

DBEEO0QAaa#FER rwnr
o Input
From File @

From Clinboard  (F)

hd Transform

All ransforma =
Case @
Shap &
Gione @

Compare Cols  (7)
Concai Cols {'—_h
CegyCols ()
Count @
® ' g

Date Format LA}

testl.csv

22 ool % B4 rEWE

Dadupe (?::
Extract l:z)
Fill &
Eilter .:_r:l
Gather (::".

1 (':5‘:
il @&
@

Jmvseript ()
@

Easy Data Transform

testicsy D52
File: MUsersiandybiDeskiop/fiest].cov
watch file
Dielimiter:  Automatic
Encoding: Automatic E
Igniare: First O rowis) =
has header
trim whitespace
simplify whitespace
ignare empty rows
Alias: test]
Carnmet:
C||% & Show first Wrows [
tithe  first rama | lastname  suffic | display name
1 L Andrew  Adams Mr Andrew Adams.
2 WS Mikki Adams Mrs Nikki Adarms
3 Ms Rose Atwell Ms Rose Atwell
4 Me  Colin Aol Mr Colin Ayer
5 Mrs  Michelle Slairg Mrs bichelie Blairg
8 M Siman [Blaire Mr Simon Blaire
7 Mr  Albert Brown Mr Albert Brown
@ Mz Cynthéa  Brown Mrs Cynthia Brown
8 Miss Jane Brown Mrs Jane Brown
10 M David Burgess Mr David Burgess
] Email us questionsffesdback
LT
wu
Q, Fifter calurm
title
first name:
last name
uffix
0 of 22 columns selected
Change case 10;  Lower Case E

Comment:
Change the case in the selected column(s).

G B & Show first 10 rows

tithe  first rame  lastname  suffic  display name

1 iy Andrew  Adams Mr Andrew Adams.
2 Mirs  Nikdki Adams Mrs Nikki Adams
3 Ms Rose Arwell Ms Rosa Atwell

4 M Colin Aper Mr Colin Ayer

5 Mrs Michelle Blaire Mrs Michalle Blaire
& Mr Simon  Blaire Mr Siman Blaire

7 M Albert Brawn Mr Albert Brawn

8 Mrs Cynthéa  Brown Mrs Cynthia Brown
8 Miss Jane [Brawn Mrs Jane Brown

0 M Dawig [Burgess Mr David Burgess

Last 54 raws nol shawn

] Email us questionsffeedback
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In the Right pane, check one of the columns and set Change case to to Upper case. All the
text in that column will now be converted to upper case.

Case @ E

E 'Q Filter columns

title
Irst name

last name

enffiv

1 of 22 columns selected

Comment;

Change the case in the selected column(s).

22 cols x 64 rows

4 Show first 10 rows E

first name last name suffix meal specia

Andrew Adams

2 | MRS |Mikki Adams

You can create a sequence of transforms to perform complex manipulations.

v Case Y Dedupe

39 caols x 50 rows

[ testl.csv

v v Sort

39 cok x 50 rows

39 mls x50 raws

39 cals x 50 raws

Some transforms require more than one input dataset. For example, to stack two tables, one
on top of the other:

¢ Select File>New to start again. Don't save the changes.

¢ Drag two data files onto the Center pane.

e Select both input items (by dragging a box around them or using cmd+click).

e Click the Stack transform button (you may need to scroll the Left pane to see the

button).
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N Easy Data Transform «1.4.0 {free trial)
DEEOQAQRQE rrwor
rrarsect [
o ®
Looiug @
@
@
@ ) testl.csv

v

ZZ cols u 64 rows

v test2.csv

23 cols x 18 rown

Subsract &)

testicsw

File:

Delimiter:
Encoding:

Igre;

[UsersfandyhiDeskiop/test].cev

watch file
Autamatic

Automatic

First O rowis)

has header

trim whitespace
simplify whitespace
ignare empty rows

Alias: test]
Carnmet:
c|m/z

tite  first rama  lastname  su
1 L Andrew  Adams
2 WS Mikki Adams
3 Ms Fose Arwell
4 M Colin Myt
5 Mrs  Michelle Slairg
6 Mr Simon  Blaire
7 Mr  Albert Brown
@ Mz Cynthéa  Brown
8 Miss Jane Brawn
10 M Dawid Burgess

B Email us

Show first Wrows [

Mix  display nama
Mr Andrew Adams
Mrs Nikki Adarms
Ms Rosa Atwell
Mr Colin Ayer
Mrs bichelie Blairg
Mr Simon Blaire
Mr Albert Brown
Mrs Cynthia Brown
Mrs Jane Brown

Mr David Burgess

questionsfesdback

The tables are now stacked one on top of the other in a new dataset item. You can choose

to match the columns by Header name or Column number.

- [ ] Easy Data Transform «1.4.0 (free trial)
DBEO0QA® # @ rhHwoor

dwemszriot ()

@

@

Mew Cod @
Nurmn Format @
Pad @&
Biver [@)]
Remove Cols  (7) testl.csv
Rename Col l:;:' ) <

22 ol x 64 rows

Recrder Cols (7
Raplace @

Aow Mum (zf\.l

Stack

Sample @ 22 esis % B rows
Sart @

sacs @ test2.csv

Sareat [ o A

Stamp @

Stats @.

Subititute @&

@
summary ()
Total @

Transpose [0

Easy Data Transform

Stack

LT
wu

Align columns byd, Header name ) E

Comment:

Stack rows of all inputs. Orders by the vertical (Y] position

af the input dataseds.

G& A 5

Tithe
1 M
2 i
3 Ms
4 i
5 Mrs
L
T M
LI
9 Miss
WM

first rame | lastname  sul

Andrew  Adams

Nikdkci Adams
Rosa Avwell
Colin Ayer
Michelle Elaire
Simon  Blaire

Albart Brown
Cynthia  Brawn
dane Brown

David  Burgess

Last 72 rows not shawn

£ email us

mow fira1 10 rews [

Mix | display name

Mr Andrew Adarms
Mrs Milkki Adams
Ms Rose Atwell
Mdr Colin Ayer

Mrs Michelle Blaire
Mr Siman Blaire
Mr Albert Brown
Mrs Cynthia Brown
Mrs Jane Brown

Mr Dvid Burgess

gquestionsifeedback
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Note that the vertical (Y) position of the inputs affects the order the datasets are stacked.
Try swapping the two inputs around and re-select Stack to see the affect.

Any changes to input files will be automatically read in. Any changes to input datasets or
transform options will be automatically propagated 'downstream’.

To export your transformed dataset to a file or the clipboard, or to view it in a local editor,
select the dataset item and click on the appropriate button in the Right pane.

Stack el

Align columns by: Header name H

Comment:
Stack rows of all inputs. Orders by the vertical () pusitinn'
of the input datasets.

([% B 7)) Show first 10 rows E,

You can also add an output item to automatically write a dataset to file whenever it

changes.
- [ ] Easy Data Transform «1.4.0 (free trial)
DBE0QA R H#E® rhHwoor
Hew Col @ Stack @[22
Hum Format "\3} : | ) ) Align columns by:  Header name H
Pad ':2-) Commaent:
Pivot 0] Stack rows of all inpuis. Orders by the vertical [Y) position
= of the input datasets.
Remove Cols {:::
Shiw Tirs1 10 rews
Rename Col 5 G [El .f " ﬂ
Peceder Cols .,‘2) tithe  first rame  lLastname  suffic  display name
S & . 1 Mr Andrew  Adams Mr Andrew Adarns:
testl.csv ke k]

M (—'} v 2 Mg Nikki Adams Mrs Milkki Adams
Samule @ e 3 Ms  Rose  Atwel s Rose Atwel
Saet ()] 4 Mr  Colin Ayer Mdr Colin Ayer
St Cad & Stack 5 Mrs  Michelle Blaire Mrs Michalle Blaire

"'k“ .
Soread [0 Y R & Mr  Simon [Bilaire Mr Siman Blaire
':' T M Albert Brown Mr Albert Brawn
Stamp @ 8 Mrs Cynthia  Brown Mrs Cynthia Brown
P ” test2.csv
Stats (7 8 Miss Jane Brown Mrs Jane Brown
— & 22 coli x 18 rows
= W M David Burgess Mr David Burgess
Summar )
Y W Last 72 rows not shawn
Total @
Transpo sd L?:'

Teim

] Email us questions/feedback

Easy Data Transform © 2020 Oryx Digital Ltd




Getting started

You will be asked for a file to write to. You can choose amongst CSV, Excel, HTML, JSON,
Markdown, TSV, vCard, XML and YAML file formats. Select CSV file.

Save As: output V
Tags:
Where: " andyb a

v CSV file (*csv)

Excel fileb{*.xlsx)

- [l [N Y [SE—

Your dataset will then be written to this file every time it changes.

- [ ] Easy Data Transform «1.4.0 (free trial)
DEEBAQARQHE® rwnn
. '::’:' output.csv @ :;1:
@ File: [Users/andyb/output.csv
@ Dalimiter: Comma () %]
@ Encading: UTF-B ™
@ . i . Values as:  Mod
(?} Byte Order Mark
@ Write mode:  Overwrite B8
@ Alias: output
® v testl.csv Comment:
(::". Lk (i & &2 Show first 10 rows B
@. tithi | TirE Al W) A SUMiE | dipli Rame
& Stack output.csv 1 Mr Andrew  Adams Mr Andrew Adams
| —d
'@ 23 cols x &Y rows 23 cols x B rows 2 Mz Mikki Adams Mrs Mikki Adams
@ 3 Ms  Rose  Atwell Ms Rose Atwed
(E’:' 4 Mr Colin Ayar Mr Colin A
yar
C8V
g v test2.cs ] ] . )
— & M Michelle Blaire Mrs Michelle Blaire
(.2) &3 coln x 18 rows
& Mr  Simon [Blaire Mr Siman Blaire
@
ToME o Albert Brown Mr Albert Brawn
o
@ 8 Mrs Cynthia Brown Mrs Cynthia Brown
7
"i) 9 Miss Jane Brown Mra Jane Brown
7
® Wl David Burgess Mr David Burgess
o Dutput
@ Last 72 rows not shown

= Email us questionsifeedback

You can also specify the delimiter and encoding for your CSV files in the Right pane.
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output.csv E Z

File: /Users/fandybfoutput.csv

Delimiter:

Encoding:

Byte Order Mark

Write mode: Owerwrite

Alias: output

Comment:

You can save your transforms to a transform template document to use again with
File>Save.

Have a play!

Tips:

e You can also paste in data from the clipboard (for example, a table from a web page or
Word document).

e The Compare cols, Filter, If and Sort transforms take account of dates, numbers and text.
You can define what date formats to recognize in the Preferences window.

¢ New columns are always added to the right of a table.

e Comparisons of text are always sensitive to case, unless stated otherwise. E.g. "CASE",
"case" and "Case" are treated differently.

e Comparisons of text are always sensitive to whitespace (e.g. spaces and tabs), unless
stated otherwise. You can use the Whitespace transform to remove leading and trailing
whitespace.

e The contents of input and output data files are not saved in Easy Data Transform, only
their locations.

e As well as stacking two datasets, you can also Join them, side-by-side, if they have a
common (‘key") column.

¢ You can insert a new transform between existing items by selecting the connection
between the items and then adding the transform.

¢ You can perform the same set of transformation on multiple files using Batch processing
or command line arguments.

e Use keyboard shortcuts to improve your productivity.

We are interested in your feedback, so please contact us to ask a question, report a bug or
request an enhancement.

Easy Data Transform © 2020 Oryx Digital Ltd
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2 Reference

2.1 User Interface
2.1.1 Main window

The Main window comprises:
¢ Main menu
e Tool bar

o Left pane
o Center pane

¢ Right pane
e Status bar

Tool bar Left pane Center pane Right pane

- [ ] Easy [ta Transform «1.4.0 {free trial)

DEEOoQAQFEE rremon

- input output.csv 3|53
] -
FromFile () File: [Users/ancybjoutput, csy -
From Clioboard  (7) Delimiter:  Comma () %]
¥ Transform Encoding:  UTF-B =]
Al transtorms A Vil .
alugs as:  Nod
W2 Byte Order Mark
'f?:' Wirite mode:  Overwrite H
)] o bestl. cov Alias: output
.\’2’) B Commaent;
@ ~
\:\ o Stack " . Dedupe o, DUtpUL.CSY [N WP Show first 10 rews [
L / —— i — —— ile | first name |lastname  suMix | display name
@ ! i Mr Andrew  Adams Mr Andrew Adams
-  testZcsv
~ 2 Mrs  Mikki Adams Mrs Mikki Adams
(7
2 3 Mz Rose  Atwall M3 Rose Atwell
@
— 4 Mr  Colin Ayer Bdr Calin Ayer
&
= 5 Mrs Michelle Elaire Mrs Michelle Blaire
@
= 6 M Simon  Blaire Mr Sirmon Blaire
]
=y 7 M Albert Brown Mr Albert Brown
(2
@ 8 Mrs Cynthia  Brown Mrs Cynthia Brown
T ) Email us questions/fesdback
Status bar Input Transform Output

2.1.2 Left pane

The Left pane shows all the available actions you can perform. Which actions are visible will
depend on what is shown in the Center pane. Which actions are enabled depends on what
is selected in the Center pane.

2.1.3  Center pane

The Center pane show the inputs, transforms and outputs you are using to transform your
data.
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2.14  Right pane
The Right pane shows details of any input, transform or output items you have selected in
the Center pane.

2.1.5 Preferences window

Check open previous file at start-up if you want to start with the last file opened.

Check give option to disable outputs when opening a file if you want the option to
disable any ouputs with write mode overwrite or append when you open a file, preventing
accidentally writing over existing files. Note that this check is never made when using the -
exit command line argument.

Check use native file windows to use the native Mac file open/save windows. There is a
known issue with macOS 10.15 that may cause crashes using native windows.

Check make a sound when processing completed if you want to make a system sound
every time processing is completed.

Set Tool bar icon size to the size of the icons you wish to display in the tool bar.

Set Right pane processing delay depending on how long you want to wait after changes in
the Right pane before starting processing. Setting the value to 0 is generally not
recommended, as this means that every single click in the Right pane will cause processing.

Set Zoom wheel behavior according to how you want the mouse wheel to work in the
Center pane. Hold down the option key while moving the mouse wheel to switch between
zoom and scroll. If Scroll direction: Natural is checked in your Mac Settings>Mouse then
the directions will be reversed.

User interface font shows the font used for the application user interface, apart from data
tables (see below). Click Choose... to choose a new font. Click Default to set it back to the
operating system default.

Data table font shows the font used in the data tables in the Right pane. Click Choose... to
choose a new font. You might prefer a monospaced (fixed width) font such as Monaco or
Courier New. Click Default to set it back to the operating system default.

The Locale language and country setting affects how some numbers and dates are

displayed. Consequently it may an affect on some transforms. It does not change the
language of the user interface, which is English only.
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Set Supported date formats to the date formats you wish to recognize. List the date
formats in order of preference, with the most likely to be used first.

2.2 Input
2.2.1 Inputdata

You need to input data before you can transform it. Data can be input by:
e dragging a file onto the Center pane; or
e clicking the From File or From Clipboard button in the Left pane

Enter the file location in File or click the browse button. For Excel spreadsheets you also
need to add a sheet name, e.g. 'MySpreadsheet.xIsx[Sheet1]".

Easy Data Transform can input data from files in the following formats:
e delimited text file (e.g. CSV or TSV) with various delimiters

o Excel xlsx or .xls

e JSON

e vCard

o XML

Easy Data Transform will make an intelligent guess at the:

e column delimiter (e.g. comma) for CSV/TSV/text files

e text encoding (e.g. UTF-8) for CSV/TSV/text files

e presence of a header row in the data

But you can also do this manually by selecting the input item and changing the Delimiter,
Encoding and has header fields in the Right pane.

You can select the input item in the Center pane and change any options related to the
output in the Right pane.
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testl.csv ¢

File: /Usersfandyb/Desktopftestl.csv
watch file

Delimiter: Automatic

Encoding: Automatic

. & @

Ignore: First O row(s)

has header

trim whitespace

simplify whitespace

ignore empty rows
Alias: test1

Comment:

Data will normally be read from the first non-blank line. Set Ignore if you want to ignore a
number of rows before you start inputting. Note that empty rows are counted.

Check trim white space to trim any whitespace (e.g. tabs or spaces) off the start or end of
data values.

Check simplify whitespace to replace any tabs or line feeds within data values with spaces
and remove carriage returns.

Check Ignore empty rows to remove any rows that have only empty values (whitespace is
not considered empty).

Check watch file if you want the file to be automatically reloaded every time that Easy Data
Transform detects that it has been changed (which will then update everything
'downstream’).

Use Meta info if you wish to add some meta information about the input dataset, e.g. the
name of an input file or the date it was created.

Use Alias to identify the file for batch processing.

Use Comment to record any notes that might be useful to a colleague or your future self.

To change the file being used by an input, select the input item and change the file location
in the Right pane (e,g, by clicking the "..." browse file button), rather the disconnecting the
input and connecting a new one. Otherwise column-related parameters downstream will be
reset.
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2.3 Transforms
2.3.1 Transform data

Transforms operate on datasets from input data or other transforms. Some transforms only
have a single input (e.g. Case), some transforms have two inputs (e.g. Join) and some
transforms have two or more inputs (e.g. Stack).

To create a transform, select one or more input and/or transform items in the Center pane
and then click the appropriate button in the Left pane.

Select from the drop-down list in the Left pane to choose which types of transform are
displayed, e.g. select Merge Transforms to show only transforms related to blending data.

You can select the transform item in the Center pane and change any options related to the
transform (e.g. which columns it acts on) in the Right pane.

The transform will be updated automatically if any input or transform 'upstream’ of it
changes.

Use Comment to record any notes that might be useful to a colleague or your future self.
2.3.2 Case

Description
Changes the case of text in one or more columns.

Inputs
One.

Options

e Check the column(s) you wish to transform.

o Set Change case to to Lower case (e.g. "text"), Upper case (e.g. "TEXT") or Title case (e.g.
"Text").

See also
e Whitespace

Easy Data Transform © 2020 Oryx Digital Ltd



Reference

233  Chop

Description
Remove characters from the start or end in one or more columns.

Inputs
One.

Options

e Check the column(s) you wish to transform.

¢ Set Length to the number of characters you want to remove.

¢ Set From to Start or End depending on whether you want to remove characters from the
start or end.

Notes

e Whitespace is counted when calculating length. You can use Whitespace to remove
whitespace before chopping.

e If you want to set a column to a fixed length use Pad and Chop together.

See also
e Extract

234 Clone
Description

Makes an exact copy of the input dataset.

Inputs
One.

Options

e None.

Notes
e Clone can be useful to simplify complicated layouts.

2.3.5 Compare Cols

Description
Creates a new column with a comparison of two other columns.
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Inputs
One.

Options

e Select the two columns you wish to compare as Column 1 and Column 2.

Notes

e Number, date and text values are treated differently. Any values that can be converted to
a number will be treated as a number. Any values that match the supported date formats
in Preferences will be treated as a date. All other values are treated as text.

e Comparisons of text are case and whitespace sensitive. You can use Case to change the
case, Whitespace to remove whitespace before filtering and Replace to get of other
unwanted characters (e.g. whitespace inside the text).

e The new column is added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.

See also

e Split Cols
2.3.6 Concat Cols

Description
Creates a new column by concatenating text from one or more existing columns.

Inputs
One.

Options
e Check the columns you wish to concatenate.
e Supply the Delimiter you wish to place between concatenated text (optional). For

example ",".
e Check keep empty if you wish to keep the delimiter for empty columns.

Notes

e If there is a header, the header of the new column is formed from the header of the
concatenated columns. You can use Rename Cols to change the new column name.

e Concatenating a single column makes a copy of the column.

e The values in the column are in the order of the columns. You can change the column
order before concatenation with Reorder Cols.

e The new column is added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.
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e The opposite of Concat Cols is Split Col.

See also
e Concat Rows
e Substitute

2.3.7 Concat Rows
Description

Concatenate multiple consecutive rows into a single row.

Example
Concatenating this dataset:

sensor datetime value
1 sensorl 1/1/18 0:00 578

3 sensor1 1/1/18 0:10 541

4 sensor2 1/1/18 0:10 702

Every 2 rows:

Concat Rows @ (P E :

{3

Create 1 row from every: 2

Gives:
sensor datetime value sensor datetime value
1 sensor1 1/1/18 0:00 578 sensor2 1/1/18 0:00 764
2 sensorl 1/1/18 0:10 541 sensor2 1/1/18 0:10 702
Inputs
One.
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Options

e Set Create 1 row from every to N to concatenate every N rows into 1 row.

Notes

e Use New Col if you need to add additional columns before concatenating rows.
Use Filter if you need to remove rows before concatenating row.

Use Rename Cols if you need to change column names after concatenating rows.
The opposite of Concat Rows is Split Rows.

See also

e Spread
e Concat Cols

2.3.8 Copy Cols

Description
Creates one or more copies of the selected column(s).

Inputs
One.

Options
e Check the columns you wish to copy.
¢ Set Copies to the number of copies you want to make of each checked column.

Notes

e If there is a header, the header of each new column is the original column name. You can
rename columns with Rename Cols.

e The new columns are added at the right end. You can change the column order with
Reorder Cols.

See also
e New Col

239 Count

Description
Counts the number of occurence of each item of text in the selected column.

Inputs
One.
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Options

e Select the Column whose values you wish to count.

¢ Set Sort by depending on whether you wish to sort alphabetically by the Text in the left
column or numerically by the Count in the right column.

¢ Set Order depending on whether you wish to sort Ascending or Descending.

Notes
e Date and number values are treated as text.
¢ You can use Rename Cols to change the new column name.

See also
e Pivot
e Stats

e Summary
2.3.10 Cross

Description

Creates an output from combining every possible row combination of each input. E.g. if the
first input has N1 rows and the second input has N2 rows, then the result will have N1 X N2
rows. Also known as a 'Cartesian product' or 'cross join'.

Example
letter
I L . letter number
' Clipboard 1A 1
\ 1 col x 3 rows 2A 2
3C
3A 3
Cross 48 |
R/ 8
2 cols x 9@ rows 5B 2
number 6B 2
11 y el
' Clipboard
20— 8C 2
I-\_\ 1 col x 3 rows
33 9cC 3
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Inputs

Two or more.

Options

e The output depends on the vertical (Y-axis) position of the inputs.

Notes
e |t can create a very large number of rows!

2.3.11 Date Format

Description
Changes the date format in one or more columns.

Example
To change from "31/1/2019" to "01-31-19" set Format from to "d/M/yyyy" and Format to
to "MM-dd-yy".

Inputs
One.

Options

e Check the columns you wish to transform.

e Supply the existing date format in Format from (see below).

e Supply the new date format in Format to (see below).

¢ The following date formats are supported for input and output:

Format Meaning

d The day as number without a leading zero (1 to 31)

dd The day as number with a leading zero (01 to 31)

ddd The abbreviated localized day name (e.g. 'Mon' to 'Sun'). Uses the locale to
localize the name.

e el The long localized day name (e.g. 'Monday' to 'Sunday"). Uses the locale to
localize the name.

M The month as number without a leading zero (1 to 12).

MM

The month as number with a leading zero (01 to 12)
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Format Meaning

MMM The abbreviated localized month name (e.g. 'Jan' to 'Dec’). Uses the locale to
localize the name.

- The long localized month name (e.g. 'January' to 'December’). Uses the locale to
localize the name.

vy The year as a two digit number (00 to 99).

Yyyy The year as a four digit number. If the year is negative, a minus sign is
prepended in addition.

Notes

e The Locale set in the Preferences window is used to decide how the date is represented
(e.g. names of months and days).

e You can also use Split Col to split a date into its component parts. For example to split
"31/1/2019" into day, month and year components using the "/" delimiter.

e If the date to be converted has only two year digits, it is treated as a date between 1900
and 1999. E.g. "31/1/19" is interpreted in d-M-yy format as 31st January 1919.

See also
e Num Format

23.12 Dedupe

Description
Remove duplicate rows.

Example
If you are cleaning up a mailing list, you might want to dedupe on the 'email' column, after
converting all the emails to lower case.

Inputs
One.

Options
e Check the column(s) you wish to look for duplicate values in.

Notes

e Rows are considered duplicates if they have exactly the same value in all the columns
selected.

e Comparisons are case and whitespace sensitive. You can use Case to change the case and
Whitespace to remove whitespace before deduping.
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e When several rows are duplicates, only the top one is retained.

See also
e Dedupe a dataset
2.3.13 Extract

Description
Extract a length of text in one or more columns.

Inputs
One.

Options

e Check the column(s) you wish to transform.

¢ Set Length to the length you want values in selected columns shortened to.

e Set From to Start or End depending on whether you want to take from the start or end.

e If From is Start then Offset is the offset of the first character from the start. If From is
End then Offset is the offset of the last character from the end.

Notes

e Whitespace is counted when calculating length. You can use Whitespace to remove
whitespace before extracting.
e If you want to set a column to a fixed length use Pad and Extract together.

See also
e Chop
2.3.14 Fill

Description
Fill empty cells in selected columns with the next non-empty cell value above/left
(depending on direction of fill).

Example

This is useful for filling in gaps in hierarchical tables. For example filling down the first two
columns:
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Country 1 Area 1 City 1 Country 1 Area 1 City 1

City 2 Country 1 Area 1 City 2

City 3 * Country 1 Area 1 City 3

Area 2 City 1 Country 1 Area 2 City 1
City 2 Country 1 Area 2 City 2
Inputs
One.
Options

e Check the column(s) you wish to fill.
¢ Select Direction depending on the direction you wish to fill from.

2.3.15 Filter

Description
Removes rows based on number, date and text values in selected columns.

Inputs
One.

Options

e Click the '+' button to add a new filter criteria.

e Click the 'x' button to delete the selected filter criteria.

¢ Select Keep if you want to keep matching rows and Remove to remove matching rows.

¢ Select Matching all to match on all criteria (e.g. criteria 1 and criteria 2). Select Matching
any to require a match on one or more criteria (e.g. criteria 1 or criteria 2).

e Set Column to the column you wish to match.

e Set Op. to the comparison operator.

¢ Set Value to the value you wish to compare.

Notes
e A filter row is ignored if the Value column is empty , except when Op. is Equal to, Not
equal to, Matches regex or Doesn't match regex.
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e Number, date and text values are treated differently for Equal to, Greater than, Less
than, Greater than equal, Less than equal and Not equal to operations. Any values that
can be converted to a number will be treated as a number. Any values that match the

supported date formats in Preferences will be treated as a date.

e All values are treated as text for Contains, Starts with, Ends with, Matches regex, Is not,
Doesn't start with, Doesn't end with and Doesn't match regex operations.

e Comparisons of text are case and whitespace sensitive. You can use Case to change the
case, Whitespace to remove whitespace before filtering and Replace to get of other
unwanted characters (e.g. whitespace inside the text).

e See here for more details on Regular expressions (regex).

2.3.16 Gather

Description

Gather multiple columns into new key and value columns. Also called unpivot, long pivot or

group by.

Example

salesman area Q1

2 Bob East 4.5

With columns Q1, Q2, Q3 and Q4 gathered:

Q2

79

Q3

1 Alice North 11.3 89.3 443

8

Q4
18

2

Gather

EA
Eu

E 'Q Filter columns

salesman
area

o1

Q2

Q3

Q4

4 of 6 columns selected

(< J B R

Comment:
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Gives:
salesman area Quarter Amount

1 Alice North Q1 11.3
2 Alice North a ;
3 Alice North Q3 ;
4 Alice North a ;
5 Bob East Q1 4.5
6 Bob 79
7 Bob East Q3 8
8 Bob East E e

Inputs

One.

Options

e Select the Columns you wish to gather.

¢ Set Key column name to the name of the new key column, which will have values based
on the names of the columns selected.

¢ Set Value column name to the name of the new value column, which will have values
based on the values in the columns selected.

Notes

e New columns are added at the right end. You can change the column order with Reorder
Cols.

e You can merge the value and key columns into a single column with Concat Cols.

e The opposite of Gather is Spread.

See also
e Split Rows
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23.17 f

Description
Sets the value of a new column based conditionally on values in one or more other columns.

Inputs
One.

Options

e Click the "+IF' button to add a new IF/ELSE IF.THEN condition.

e Click the '+AND' button to add an AND to the selected IF/ELSE IF..THEN.
e Click the 'x' button to delete the selected IF/ELSE IF. THEN/AND.

e The Logic column shows the type of row.

e Set Column to the column you wish to match.

e Set Op. to the comparison operator.

e Set Value to the value you wish to compare.

Notes
e The THEN and ELSE values can use column variables. For example:

IF x =0
THEN $ (1)
ELSE
$(2)

e You can simulate OR with multiple IF statements. For example:

IF x = 10R vy =2
THEN 3

Is equivalent to:

IF x = 1
THEN 3
ELSE IF y = 2
THEN 3

e Number, date and text values are treated differently for Equal to, Greater than, Less
than, Greater than equal, Less than equal and Not equal to operations. Any values that
can be converted to a number will be treated as a number. Any values that match the
supported date formats in Preferences will be treated as a date.

e All values are treated as text for Contains, Starts with, Ends with, Matches regex, Is not,
Doesn't start with, Doesn't end with and Doesn't match regex operations.
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e Comparisons of text are case and whitespace sensitive. You can use Case to change the
case, Whitespace to remove whitespace before filtering and Replace to get of other
unwanted characters (e.g. whitespace inside the text).

e See here for more details on Regular expressions (regex).

See also

e Lookup
2.3.18 Insert

Description
Append/prepend text to one or more columns.

Inputs
One.

Options

e Check the column(s) you wish to transform.

¢ In Insert put the text you want to insert. You can use a column variable.
¢ In At put the position you want the text inserted.

Notes
e You can use Whitespace to remove whitespace before inserting.

See also
e Pad
e Extract

2.3.19 Interpolate
Description

Interpolate values for a dataset based on numerical sample-value pairs in another dataset
and puts the result in a new column.

Example

If you have time and temperature datasets for sensors A and B with different sampling
frequencies, you merge the two datasets by interpolating the temperature values of B for
for the times A was measured.

First dataset:
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time A temperature A
100 1.134
iz 1.0 3.778
320 2.773
430 5.039
540 3.333
6 5.0 2.874

Second dataset:

time B temperature B
100 0.000
220 1334
340 2.697
46.0 3931

Interpolation transform:
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sensor-A.csv
v

2 cols x 6 rows

-JInterpolate

3 cols x 6 rows

sensor-B.csv
v

2 cols x 4 rows

Interpolate Q-2 [ie

Top Sample column:  time A

Bottom value column: temperature B

Bottom Sample column:  time B H
]
T

Interpolation type: Linear

Result:
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| time A temperature A Interpolate temperature B

100 1.134 0
I2 1.0 3.778 0.667
320 2.773 1334
430 5039 2.015
54.0 3.333 2.697
650 2.874 3.314

Inputs

Two.

Options

e Place the dataset you want to modify as the top input and the dataset you want to
sample values from as the bottom input.

¢ Select Top sample column for the column whose values you wish to sample.

¢ Select Bottom sample column for the column that matches the top sample column in
the bottom dataset.

¢ Select Bottom value column for the column that contains the values.

¢ Set Interpolation type to the type of interpolation you wish to use.
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Piecewise interpolation (image from Wikipedia)
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Linear interpolation (image from Wikipedia)

Notes

e If your sample is below the first sample in the bottom dataset, the first value will be
returned.

e If your sample is above the last sample in the bottom dataset, the last value will be
returned.

e Easy Data Transform will try to guess sensible default values for Top sample column,
Bottom sample column and Bottom value column based on column contents.

o If the first input has a header, this will be used for the output.

e The new column is added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.

e Use Num Format to change the precision of the results.

See also

e Lookup
e Join
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2.3.20 Intersect

Description
Keep only rows from the top dataset with key values that are present in the lower dataset.

Inputs

Two.

Options

e The output depends on the vertical (Y-axis) position of the inputs.

e Select Top key column for the column you want to match in the top input dataset.

¢ Select Bottom key column for the column you want to match in the bottom input
dataset.

Notes

e If there are 10k rows or less in both datasets, Easy Data Transform will try to guess
sensible default values for Top key column and Bottom key column based on column
header names and contents.

o If the first input has a header, this will be used for the output.

e All values are treated as text and comparisons are case and whitespace sensitive. You can
use Case to change the case and Whitespace to remove whitespace before the intersect.

¢ Does not remove duplicates. You can use Dedupe to do this.

e You can use Concat Cols to join several columns together (e.g. 'first name' and 'last name’
columns) to form a key column.

e You can use Row Num to create a unique key column.

See also
e Subtract

2.3.21 Javascript

Description
Create a custom transform using Javascript (ECMAScript).

Easy Data Transform allows you to carry out a wide range of data transformations without
programming. But sometimes you might need a specialist transformation that can't be done
with the built-in transforms. For that you can use the Javascript transform. It allows you to
write the body of a Javascript function, to calculate a value for each row in a new column.
Existing column values can be used as variables.

Javascript is a fully-fledged programming language and can perform arbitrarily complex
transforms. It can handle numbers, dates and text.
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Examples
To multiply the value in column 'items' by the value in column ‘item price":

return $(items) * $(item price);

To concatenate 'last' and 'first' columns with a comma and a space:

return $(last) + ', ' + S$(first);

To calculate the biggest of columns 'v1' and 'v2"
return Math.max( $(vl), $(v2) );

To determine whether phone numbers in the '‘phone_num' column are valid using a regular
expression:

const validPhoneNum = /~[\+]2[(12[0-91{3}[)]12[-\s\.12[0-91{3}[-\s\.1?[0-9](4,6}$/;
if ( validPhoneNum.test ( $(phone num) ) )

return "valid";
else

return "invalid";

To calculate the number of years difference between Javascript compatible dates in column
1 and column 2:

return new Date( $(1) ).getFullYear() - new Date( $(2) ).getFullYear();

To calculate the number of milliseconds between a date in the 'date’ column and 1st Jan
2000:

return new Date( $(date) ) - new Date( "2000-01-01" );

To calculate the number of whole days difference between a date in the 'created' column
and today (negative for future dates):

return Math.floor( ( new Date() - new Date( $(created) ) ) / ( 1000*60*60*24 ) );
To reverse the text in the ‘key' column:

var newString = $(key);

for (var 1 = a.length - 1; 1 >= 0; i--) {
newString += al[il;

}

return newString;
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Inputs
One.

Options

e Enter your script into the Javascript field. The script should be the body of a Javascript
function.

e Select a column from Insert variable to add that column variable into the Javascript field
at the current cursor position.

e Click the Evaluate button to evaluate your Javascript expression over every row and show
any errors.

Notes
e The Javascript transform is calculated every time:
o The Evaluate button is pressed.
o The Javascript transform item is unselected in the Center pane and script changes have
been made without the Evaluate button being clicked.
o The item upstream of it changes.

e Numeric values should use dot ('.") as the decimal separator and have no group separator.
E.g. 1234.5 is valid, but 1,234.5 and 1.234,5 are not, regardless of the locale set in the
Preferences window. You can use the Num Format and Replace transforms to put
numeric data in the correct format before processing the Javascript transform.

e The new column is added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.

e Any errors from the Javascript engine are shown in a message window when Evaluate is
clicked.

e The Javascript Date() object evaluates to the number of milliseconds since 1 January 1970
UTC. Date() is the current date.

e Date values passed to Javascript Date() objects should be in ISO ('yyyy-mm-dd’) format,
e.g. '2020-01-31" (not '2020-1-31").

e If you want to carry out your transform across more than one dataset, you should Join
them first.

e The Javascript transform is very versatile and quite fast. But is not as fast as built-in
transforms. So we recommend you use built-in transforms where possible.

e Javascript running in Easy Data Transform is not 'sandboxed' and has the same privileges
as the Easy Data Transform executable. However the Javascript does not have access to
window(), XMLHttpRequest() or ActiveXObject(). So we aren't aware of any way that a bad
actor could damage your system from Javascript sent in a .transform file.

e Javascript is far too big a topic to cover here. However there are many detailed resources
online. If you are stuck contact support.

e If you only want to combine text from columns, use the simpler Substitute transform.
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See also
e Find the difference between dates/datetimes

2.3.22 Join

Description
Join two inputs based on common (key) columns, e.g. on an email address or id column
present in both inputs.

Example
Joining these two datasets by the ID column in each:

Name ID DOB ID Department Level
651 Engineering 1\

[

John Black 001 1966-0?&

Paul White [802 1973-03-11 2|003 Engineering 2

+

Barry Green 003 1977-12-30 004 Marketing 1

Jane Brown 004 1980-11-03 41002 Sales 2

5l Sales 3
Q J

L

Jill Taupe 100S 1981-[!3—_{})

Gives:

MName 1D DOB Department Level

1 dg}'l_ﬂ Black Gﬂl\lgﬁﬁ-{]?-ﬂ Engineering 1 )
2|Paul White | 002 1973-03-11 Sales 2
3|Barry Green{l003 [1977-12-3(} Engineering 2

4lane Brown| 004 [1980-11-04 Marketing 1

wTaupe @31981—{]3—(}; Sales 3y

LA

Inputs

Two.
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Options

e The output depends on the vertical (Y-axis) position of the inputs.

¢ Select Top key column for the column you want to match in the top input dataset.

¢ Select Include top non-matching rows if you want to include in the output any rows in
the top input with no matching value in the bottom input.

¢ Select Bottom key column for the column you want to match in the bottom input
dataset.

e Select Include bottom non-matching rows if you want to include in the output any rows
in the bottom input with no matching value in the top input.

Top Include top non- Bottom Include top non- Also known as:
matching rows checked matching rows checked

No No Inner join

No Yes Right outer join
Yes No Left outer join
Yes Yes Full outer join
Notes

¢ Join merges two datasets side-by-side (horizontally). To merge datasets one on top of the
other (vertically) use Stack.

o If there are 10k rows or less in both datasets, Easy Data Transform will try to guess
sensible default values for Top key column and Bottom key column based on column
header names and contents.

o All values are treated as text and comparisons are case and whitespace sensitive. You can
use Case to change the case and Whitespace to remove whitespace before the intersect.

e If a key value occurs M times in the first dataset and N times in the second dataset, you
will get M x N rows with this key value. You can use Dedupe to remove rows with
duplicate key values.

¢ Use Concat Cols to join several columns together (e.g. ‘first name' and ‘last name'
columns) to form a key column.

e Use Row Num to create a unique key column.

e Use the Cross transform for cross joins.

Cascade multiple joins to join more than 2 datasets.
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cust omers. coy
o

1l s ¥ rows

Join
o
24 ma w130 Mw i

arders.csv
o

34 oo K B30 el

order-details.
W

% cols x 3. Jkrown

suppliers.csv
12 com w I rows JCII'I

51 coi x 2.3k mwa

See also

¢ Video: How to join Excel files
e Cross

e Lookup

e Interpolate

e Merge datasets

2.3.23 Lookup

Description
Looks up the values of a column in the top input dataset in the bottom input dataset and
puts the result in a new column.

Example

If you have one dataset with category IDs and another dataset with category IDs and
category names, you can create a new category name column in the first dataset by looking
up the category ID in the second dataset.

First dataset:
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ProductlD ProductName SupplierlD CategorylD
11 Chai 1 1
12 |12 Chang 1 1
3 3 Aniseed Syrup 1 2
!4 4 Chef Anton's Cajun Seasoning 2 2
5 5 Chef Anton's Gumbo Mix 2 2

Second dataset:

CategorylD |CategoryName Description
1)1 Beverages Soft drinks coffees teas beers and ales
22 Condiments  Sweet and savory sauces relishes spreads and seasonings
33 Confections Desserts candies and sweet breads

Lookup transform:

products.csv

4 cols x 77 rows

v Lookup

5 cols x 77 rows

categories.csv

3 cols x8 rows
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Lookup

Top lookup column:  CategorylD
Bottom Lookup column: CategorylD

Bottom value column: CategoryMame

(O OR O R R
P Ol W

Bottom values used: First

Value if not found:

Comment:
Result:

ProductlD ProductName SupplierlD CategorylD Lookup CategoryName
11 Chai 1 1 Beverages
2 |2 Chang 1 1 Beverages
33 Aniseed Syrup 1 2 Condiments
4 4 Chef Anton's Cajun Seasoning 2 2 Condiments
5 5 Chef Anton's Gumbo Mix 2 2 Condiments

Inputs
Two.
Options

¢ Place the dataset you want to modify as the top input and the dataset you want to lookup
values from as the bottom input.

e Select Top lookup column for the column whose values you wish to lookup.

¢ Select Bottom lookup column for the column that matches the lookup in the bottom
dataset.

¢ Select Bottom value column for the column that contains the values.

¢ Set Bottom values used to First if you want use the first match in Bottom lookup
column and All if you want to use all matches.

¢ Set Value if not found to the value you want to set for values in Top lookup column
that do not exist in Bottom lookup column.

Notes

e Easy Data Transform will try to guess sensible default values for Top lookup column,
Bottom lookup column and Bottom value column.

e Bottom values used is only important if there are duplicates in Bottom lookup column.
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e If the first input has a header, this will be used for the output.

e All values are treated as text and comparisons are case and whitespace sensitive. You can
use Case to change the case and Whitespace to remove whitespace before the intersect.

e If you want to lookup values in multiple columns, use Concat Cols to join several columns
together to form new columns.

e The new column is added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.

See also
o If

e Interpolate
e Join

2.3.24 New Col

Description
Adds a new column, filled with a given value.

Inputs
One.

Options
¢ Set New column value to the value for every cell of the new column. You can leave it
blank for an empty column.

Notes
¢ New columns are always added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.

See also

e Copy Cols
e Remove Cols

2.3.25 Num Format

Description
Change the number format in one or more columns.

Inputs
One.
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Options

e Check the column(s) you wish to transform.

¢ Set Format to the new number format (see below).

e For the e, E, and f formats, Precision represents the number of digits after the decimal
point. For the g and G formats, Precision represents the maximum number of significant
digits (trailing zeros are omitted). For the s format Precision is ignored.

e Check use group separators to include the group separators for your locale. E.g. to turn
1234567 to 1,234,567 for a UK or US locale.

¢ The following number formats are supported:

Format Meaning
€ Format as [-]9.9e[+]|-]999.
E.g. 1234567.89 is shown as 1.235e+06.
2 Format as [-]9.9E[+]-]999.
E.g. 1234567.89 is shown as 1.235E+06.
£ Format as [-]9.9.
E.g. 1234567.89 is shown as 1234567.89.
g Use e or f format, whichever is the most concise.
G Use E or f format, whichever is the most concise.
S The shortest accurate representation for the given

number without exponents.
E.g. 1234567.00 is shown as 1234567.

Notes

e The Locale set in the Preferences window is used to decide how the number is
represented (e.g. group and decimal separators).

e Non-numerical values are ignored.

¢ You can also use Extract and Pad to change the number of characters.

See also
e Date Format
2.3.26 Pad

Description
Pad text to a minimum length in one or more columns.

Inputs
One.
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Options

e Check the column(s) you wish to transform.

¢ Set Minimum length to the length you want values in selected columns padded to.
Values this length or longer are unaffected.

¢ Set Pad to Left or Right depending on where you want any padding characters added.

¢ Set Pad with to the character you want to pad with.

Notes
e Whitespace is counted when calculating length. You can use Whitespace to remove
whitespace before padding.

2.3.27 Pivot

Description
Creates a pivot table to summarise values for one or two columns.

Inputs
One.

Options
¢ Set Column to the column values you want to use as columns in your pivot table.
¢ Set Rows to the column values you want to use as rows in your pivot table.
¢ Set Values to the column you wish to summarize.
e Set Summarize by to how you wish to summarize the values:
o Sum show the sum of the values. Non-numeric and empty values are ignored.
o Maximum shows the largest value. Non-numeric and empty values are ignored.
o Minimum shows the smallest value. Non-numeric and empty values are ignored.
o Average shows the arithmetic mean of the values. Non-numeric and empty values are
ignored.
o Count shows the number of non-empty values. A value that contains whitespace is not
considered empty.
o Standard deviation is the sample standard deviation (equivalent to Excel function
stddev.s).
e Set Set non-calculated depending on how you want to set cells not calculated by the
pivot.

See also
e Count
e Stats

e Summary
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2.3.28 Remove Cols

Description
Removes columns.

Inputs
One.

Options

e Uncheck the column(s) you wish to remove.

Notes
e The column will be removed from any dataset ‘downstream’.

See also
e New Col

2.3.29 Rename Col

This transform is deprecated. Use Rename Cols instead.

Description
Rename a column header.

Inputs
One.

Options
e Select the column header you wish to rename in Column.
¢ Set Rename to to the new column header name.

Notes
e The names of column headers do not have to be unique.

2.3.30 Rename Cols

Description
Rename column headers.

Inputs
One.
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Options

e Change the column headers using the New name column.

e Click Lower to change all the names in the New name column to lower case.

e Click Upper to change all the names in the New name column to upper case.

e Click Title to change all the names in the New name column to title case.

e Click Reset to change all the names in the New name column back to their original name.

Notes
e The names of column headers do not have to be unique.
2.3.31 Reorder Cols

Description

Reorder columns.

Inputs
One.

Options

Drag the columns into the desired order (left-most at the top).

Notes
You can also rename columns with Rename Cols and remove unwanted columns with

Remove Cols.
2.3.32 Replace

Description
Replace text in one or more columns.

Examples
To turn 0123456789 into (+44) 1234 56789 using a Regular expression:

Match type: Regex H

Replace: O(\d\d\d\d) (\d\d\d\d\d)
With: (+44)\1\2

To replace values that are empty or contain only whitespace with 0 using a Regular
expression:
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Match type: Regex H
Replace: "s*%
With: 0
Inputs
One.
Options

e Check the column(s) you wish to transform.

e Choose whether to use text or Regular expression matching.

¢ In Replace put the text you want to replace. You can use a column variable.

¢ In With put the text you want to replace it with. You can use a column variable.

Notes
e Comparisons are case and whitespace sensitive. You can use Case to change the case and
Whitespace to remove whitespace before replacing.

See also
e Insert
e Substitute

2.3.33 Row Num

Description
Add a new column that contains the row number.

Inputs
One.

Options

e Set Start at to the number you want to use for the first row.

¢ Set Increment to the amount you wish to increment by.

e set Every to how often to apply the increment (e.g. set to 5 to increment once every 5
rows).

Notes
e The new column is added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.
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2.3.34 Sample

Description
Selects a subset of rows from the input.

Inputs
One.

Options

¢ Set Rows to the number of rows you want to output. If it is the same or greater than the
number of rows in the input, then the input will be unaffected.

¢ Set Select depending on how you want the rows sampled.

¢ Check Disable sampling to turn off sampling. If sampling is disabled, the transform does
nothing.

Notes

e If you are transforming a large dataset, then you can use Sample to test a small subset.

e If you need to do something more complex than Sample can handle (e.g. keep only rows
500 to 1000) then use Row Num followed by a Filter. For the most complex cases use
Row Num, followed by Javascript, followed by a Filter. E.g. this Javascript function
returns 1 for every 10th row between 1000 and 2000 and 0 otherwise:

return $(Row Num) >= 1000 & $(Row Num) <= 2000 & $(Row Num) % 10 == 0;

2.3.35 Sort

Description
Sorts rows by one or more columns.

Inputs
One.

Options

e Click the '+' button to add a new sort level.

e Click the 'x' button to delete the selected sort level(s).

e Click the up arrow to move the selected sort level(s) up.

¢ Click the down arrow to move the selected sort level(s) down.

e Set Column to the column you want to sort by.

¢ Set Order depending on whether you want to sort this column Ascending or
Descending.
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Notes

e If you add multiple levels, it will sort by level 1 then level 1 values that are the same will be
sorted by level 2 etc.

e Number, date and text values are treated differently for comparison purposes.

e Any values that can be converted to numbers will be treated as numbers.

e Any values that match the supported date formats in Preferences will be treated as dates.

e Comparisons of text are case and whitespace sensitive. You can use Case to change the
case and Whitespace to remove whitespace before filtering.

2.3.36  Split Col

Description
Creates one or more new columns by splitting text at delimiters in a selected column.

Inputs
One.

Options

e Select the Column you wish to split.

e Supply the Delimiter you wish to use to split the column.

¢ Set Ordering depending on how you want to order values after splitting.

e Check keep empty if you wish to honor delimiters with nothing in between.

¢ set Min. new cols to the minimum number of new columns you wish to add.

¢ set Max. new cols to the maximum number of new columns you wish to add (ignored if
less than minimum).

Notes

e If no Delimiter is supplied then no new columns are created.

¢ New columns are added at the right end. You can change the column order with Reorder
Cols.

o If there is a header, the header of the new column is based on the original header. You
can change the column name with Rename Cols.

e The opposite of Split Col is Concat Cols.

See also
e Split Rows

2.3.37 Split Rows

Description
Split each row into multiple rows.
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Example
Splitting these rows:

| Guest title Guest first name Guest last Spouse title Spouse first name Spouse last name

1 Mr John Smith Dr Jane Smith

2 Mr Bill Brown Mrs Andrea Brown

Before each column containing 'title":

Split Rows

© when column name € H title

Gives:
Guest title Guest first name Guest last
1 Mr John Smith
3 Mr Bill Brown
4 Mrs Andrea Brown
Inputs
One.
Options

¢ Split by column name:
o Each row will be split before each column that matches the criteria. The matching is
sensitive to case and whitespace.
e Split a fixed number of times:
o Define the number of times you want to split each row, starting at which column and
then every N columns.
o The split is added before the designated columns.
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o Splits after the last column are ignored. So you can set times to a large number if you
don't know how many columns there will be.
¢ Split automatically:
o Find the first column name that appears more than once and split each row before each
column with that name.

Notes

e Splits added before the first column are ignored, as there is already a split there.

e Use New Col or Rename Cols if you need to add additional columns or rename columns
before splitting rows.

e The opposite of Split Rows is Concat Rows.

See also
e Gather

e Split Col
2.3.38 Spread

Description
Spread a column into multiple new columns. Also called wide pivot or crosstab.

Example

salesman area Quarter Amount

1 Alice North Q1 113

2 Alice North a 89.3

3 Alice North Q3 443
4 Alice North a 18
5 Bob East Q1 45

6 Bob East 79

7 Bob East Q3 8

8 Bob East E e
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With Quarter and Amount columns spread:

Spread E i
Key column: Quarter H
Value column:  Amount H

Gives:
salesman area QING2NG3NG4
1 Alice North 11.3 893 443 18
2 Bob East 45 79 8 33

Inputs

One.

Options

e Select the Key column and Value column you wish to spread.

¢ Missing values is used for values missing from the input dataset.

¢ set Min. new cols to the minimum number of new columns you wish to add.

¢ set Max. new cols to the maximum number of new columns you wish to add (ignored if
less than minimum).

Notes

o If there are rows that are duplicates, apart from the value column, this will cause errors.

e New columns are added at the right end. You can change the column order with Reorder
Cols.

¢ You can merge the new columns into a single column with Concat Cols.

e The opposite of Spread is Gather.

2.3.39 Stack

Description
Stack the rows from inputs, one on top of the other.

Example
Stacking these two datasets by the ID column in each:
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MName 1D DOB
John Black 001 01/07/1966

Paul White 002 11/03/1973

Barry Green 003 30/12/1977,

+

i Mame ID DOB
Jane Brown 004 03/11/198

! Jill Taupe 005 01/03/198

Gives:

Name ID DOB
1£E"|—n Black 001 1966-07-01

2|Paul White 002 1973-03-11

3 @r}f Green 003 19??-12-_59

4 Jfane Brown 004 1980-11-02\

SM]lTaupe 005 1981—03-[5}

Inputs

One or more.

Options

¢ Select Align columns by to Header name if you want line up column values by header
name (e.g. the 'id' column in input 1 with the 'id' column in input 2) and Column number
to align by the column number (e.g. the first column of input 1 with the first column of
input 2). The headers will be matched case insensitive (e.g. 'id' to 'ID"), if no case sensitive
match is possible.

e The output depends on the vertical (Y-axis) position of the inputs.
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Notes

e Stack merges two datasets one on top of the other (vertically). To merge datasets side-by-
side (horizontally) use Join.

e If you align by Column number the header of the first input is used.

See also

e Cross

e Join

e Merge datasets
2340 Stamp

Description
Adds a time/date stamp as a new row or a new column.

Inputs
One.

Options

e Supply the processing date/time format in Format (see below).

Format Meaning

d The day as number without a leading zero (1 to 31)

dd The day as number with a leading zero (01 to 31)

ddd The abbreviated localized day name (e.g. 'Mon' to 'Sun'). Uses the system locale
to localize the name.

ceeel The long localized day name (e.g. 'Monday' to 'Sunday'). Uses the system locale
to localize the name.

M The month as number without a leading zero (1 to 12).

= The month as number with a leading zero (01 to 12)

MM The abbreviated localized month name (e.g. 'Jan' to 'Dec'). Uses the system locale
to localize the name.

e The long localized month name (e.g. 'January' to 'December'). Uses the system
locale to localize the name.

Yy The year as two digit number (00 to 99).

yyyy The year as four digit number. If the year is negative, a minus sign is prepended in
addition.

h The hour without a leading zero (0 to 23 or 1 to 12 if AM/PM display).

ol The hour with a leading zero (00 to 23 or 01 to 12 if AM/PM display).

f The hour without a leading zero (0 to 23, even with AM/PM display).

i The hour with a leading zero (00 to 23, even with AM/PM display).

m The minute without a leading zero (0 to 59).
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Format Meaning

e The minute with a leading zero (00 to 59).

S The whole second without a leading zero (0 to 59).

Ss The whole second with a leading zero where applicable (00 to 59).

z The fractional part of the second, to go after a decimal point, without trailing

zeroes (0 to 999). Thus "s.z" reports the seconds to full available (millisecond)
precision without trailing zeroes.
AP or A The fractional part of the second, to millisecond precision, including trailing.
ap ot 2 Use am/pm display. a/ap will be replaced by either "am" or "pm".
The timezone (for example "CEST").

e Select from Position whether you want the stamp row added to the start or end of the
dataset or to every row in a new column.

Notes
e If you add the stamp to Every Row you can move the column using Reorder Cols.

See also
e Meta information
2.3.41 Stats

Description
Calculates the sum, minimum, maximum, average, median or standard deviation of numeric
values by column or row in one or more selected columns.

Inputs
One.

Options
e Check the column(s) you wish to calculate stats for.
¢ Set Calculation to the statistic you want to calculate.
¢ Set On depending on whether you wish to calculate the statistics for columns, rows or
both.
o If On is set to Columns an extra row with the results is added to the bottom.
o If On is set to Rows an extra column with the results is added to the right.
o If On is set to Columns and rows an extra row with the results is added to the bottom
and extra column with the results is added to the right. The bottom right cell
contains the calculation across all values.
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2.3.42

Notes

The average is the arithmetic mean.

The standard deviation is the sample standard deviation (equivalent to Excel function
stddev.s).

¢ Non-numerical and empty values are ignored.

Use Num Format to change the precision of the results.

See also
e Count

e Pivot

e Summary
Substitute

Description
Substitute column values into text.

Example
To create SQL statements to insert 'Country’, 'Year', 'Key' and 'Value' column values:

INSERT INTO mytable (Country, Year,Key,Value) VALUES ($(Country),$(Year),$(Key),$ (Value

Substitute ] @||sZ

New column name: SQL

Substitution script:

INSERT INTO mytable(Country,Year,Key,Value) VALUES (3(Country),$(Year),$(Key), $(Value));

Insert variable:  <select> H Evaluate

Comment:

Substitute column values into text.

G & 7
Country Year | Key Value saQL
1 Afghanistan 1999 cases 745 INSERT INTO mytable(Country,Year Key Value) VALUES (Afghanistan,1999,cases,745);
Inputs

One.
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Options

e Enter your substitution script into the Substitution script field.

e Select a column from Insert variable to add that column variable into the Substitution
script field at the current cursor position.

e Click the Evaluate button to evaluate your script over every row.

Notes
e The transform is calculated every time:
o The Evaluate button is pressed.
o The Substitute transform item is unselected in the Center pane and script changes
have been made without the Evaluate button being clicked.
o The item upstream of it changes.
e The new column is added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.
e If you want to carry out your transform across more than one dataset, you should Join

them first.
e If you need to do something more complex than this transform allows, try the Javascript
transform.

2.3.43 Subtract

Description
Remove rows from the top dataset with key values that are present in the lower dataset.

Inputs

Two.

Options

e The output depends on the vertical (Y-axis) position of the inputs.

¢ Select Top key column for the column you want to match in the top input dataset.

¢ Select Bottom key column for the column you want to match in the bottom input
dataset.

Notes

o If there are 10k rows or less in both datasets, Easy Data Transform will try to guess
sensible default values for Top key column and Bottom key column based on column
header names and contents.

e If the first input has a header, this will be used for the output.

¢ All values are treated as text and comparisons are case and whitespace sensitive. You can
use Case to change the case and Whitespace to remove whitespace before the subtract.

¢ Does not remove duplicates. You can use Dedupe to do this.
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e You can use Concat Cols to join several columns together (e.g. 'first name' and 'last name'
columns) to form a key column.
e You can use Row Num to create a unique key column.

See also
e Intersect

2.3.44 Summary

Description
Summarise the values in the selected columns.

Inputs
One.

Options

e Select the Columns you wish to summarise.

e Check check for dates if you wish to check for date values using supported date formats.
This can be slow for large datasets.

Notes

e Empty values is the number of values in the column that are completely empty. Values
with whitespace do not count as empty.

¢ Numeric values is the number of numeric of values in the column that can be interpreted
as a number.

¢ Date values is the number of values in the column that can be interpreted as a date. Only
shown if check for dates is checked.

o Text values is the number of values in the column that cannot be interpreted as empty,
numeric or date.

¢ Unique values is the number of unique values in the column. Empty values are not
counted. Date and numeric values are treated as text (e.g. '7' is treated as different to '7.0'
and '1/1/2020' is treated as different to '01/01/2020'). Comparison between values is
sensitive to case and whitespace.

¢ Min length is the minimum number of characters of a value in the column. Whitespace is
counted. Date and numeric values are treated as text.

e Max length is the maximum number of characters of a value in the column. Whitespace is
counted. Date and numeric values are treated as text.

¢ Min numeric is the minimum numeric value in the column.

e Max numeric is the maximum numeric value in the column.

¢ Min date is the minimum date value in the column. Only shown if check for dates is
checked.
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¢ Max date is the maximum date value in the column. Only shown if check for dates is
checked.

¢ Most frequent lists the most common text in the column. Empty values are not counted.
Date and numeric values are treated as text. Comparison between values is sensitive to
case and whitespace.

e You can use Whitespace to remove any whitespace at the start or end of values before
Summary.

e If you wish to have a row displayed per column you can Transpose the table.

See also

e Count

e Pivot

e Stats
2.3.45 Total

Description
Add a new column with a running (cumulative) total of the selected column.

Inputs
One.

Options

¢ Set Column to the column you want to total.

Notes

¢ Non-numerical values are ignored.

e The new column is added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.

See also
e Count

e Pivot

e Stats

2.3.46 Transpose

Description
Swap (rotate) rows and columns, so that each row becomes a column and each column
becomes a row.
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Inputs
One.

Options

e Check has header to make the new first row into a header (requires >1 row).

Notes

e If the input dataset has a header, it will become the new first column. Use Remove Cols to
remove it.

e Datasets with very large numbers of columns can be slow to display.

2.3.47 Trim

This transform is deprecated. Use Whitespace instead.

Description
Removes leading and trailing whitespace from one or more columns.

Inputs
One.

Options

e Check the column(s) you wish to transform.

2.3.48 Whitespace

Description
Tidy whitespace (spaces, tabs, carriage returns etc) in the selected column(s).

Inputs
One.

Options

e Check the column(s) you wish to transform.

e Check Trim leading and trailing whitespace to remove whitespace characters, such as
space and tab.

e Check Replace line feeds with spaces to replace LF (\n) characters with spaces.
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e Check Replace tabs with spaces to replace tab (\t) characters with spaces.

e Check Remove carriage returns to remove CR (\r) characters.

e Check Convert consecutive spaces to one space to replace 2 or more consecutive spaces
with a single space.

e Check Remove non-printable characters to remove characters of Unicode type Other_*.
This include ASCII codes 0 to 31, such as tab, line feed, carriage return, bell and
backspace. It does not remove spaces.

Notes
e The operations are carried out in top to bottom order, e.g. Replace line feeds with
spaces is carried out before Convert consecutive spaces to one space.

See also
e Case

2.4 Output
24.1 Output data

Once you have finished transforming your data you can output it in the following formats:
o CSV

e Excel

» JSON

e HTML

e Markdown

To create an output, select 1 input and/or transform item in the Center pane and then click
the To File button at the bottom of the Left pane. You can choose the file type in the file
type drop-down list of the Output window.

You can select the output item in the Center pane and change any options related to the
output in the Right pane.
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output.csv E Z

File: /Users/fandybfoutput.csv

Delimiter:

Encoding:

Byte Order Mark

Write mode: Owerwrite

Alias: output

Comment:

Set File to the location of the file you want to output. If you are writing to a .xIs or .xlsx file
the output will be written to a sheet called 'Easy Data Transform' by default. You can change
this by adding the sheet name inside [], e.g. myfile.xlsx [mysheet].

Set Delimiter to the delimiter you wish to use (only available for delimited text files, such as
CSV and TSV).

Set Encoding to the text encoding you wish to use (only available for text files).

Set Format as depending on how you want to set the Excel formatting of cells (only
available for Excel files).

Set Byte Order Mark checked write a Unicode Byte Order Mark to the file (only available
for UTF encodings).

Set Root name and Row name depending on the name you want to use for the root and
row XML records (only available for XML files).

Set Write mode to:

¢ 'Disabled' not to write to the file.

'‘Overwrite' to create a new file (if none exists) or overwrite (if the file exists).
'‘Append' to create a new file (if none exists) or append to it (if the file exists).
'‘New' to create a new file (if none exists) or do nothing (if the file exists).

Use Alias to identify the file for batch processing.

Use Comment to record any notes that might be useful to a colleague or your future self.
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2.5 File formats

Enter topic text here.
25.1  CSVformat

Easy Data Transform can input from and output to CSV format files. File extension ".csv".

CSV (Comma Separated Value) format is commonly used for exchanging tabular data
between programs.

CSV is a type of delimited text file format. Carriage return denotes the end of a row. The
column delimiter is usually commas, but not always.

Easy Data Transform supports the following column delimiters:
e comma (,)

semi-colon (;)

colon ()

pipe (|)

caret ()

For all the above delimiters:

e If a value field contains a quote (") character, then the quote will be ‘escaped’ by an
additional quote when output.

e If a value field contains a delimiter, quote or carriage return character, then the value be
surrounded by quotes (") when output.

For example:
| CategorylD CategoryName Description In stock
11 Beverages Soft drinks, coffees & teas true
1212 Condiments Sweet and savory sauces false
|
|
| 33 Confections Candies and sweet breads true
Is output as:

CategoryID, CategoryName, Description,In stock
1,Beverages, "Soft drinks, coffees & teas", true
2,Condiments, Sweet and savory sauces, false
3,Confections,Candies and sweet breads, true
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Many CSV file are not well formed. For example, they have unescaped quotes. As the CSV
format is not well-defined, badly formed CSV files can be interpreted in more than one way.
Easy Data Transform will do the best it can in these circumstances.

Tab delimited (TSV) files are treated a bit differently.

2.5.2  Excel format
Easy Data Transform can input from and output to Excel ".xIsx" and ".xIs" format files, even if

you don't have Excel installed.

Excel format is the native format of the Microsoft Excel spreadsheet application. It is
commonly used for exchanging tabular data.

Note that Excel files are typically limited to 1,048,576 rows and 16,384 columns.
2.53  JSON format

Easy Data Transform can input from and output to JSON format files. File extension ".,json".

JSON (JavaScript Object Notation) format is commonly used for exchanging data between
programs. JSON data is expected to be in UTF8 encoding.

For example:
| CategorylD CategoryName Description In stock
11 Beverages Soft drinks, coffees & teas true
122 Condiments Sweet and savory sauces false
|
|
| 33 Confections Candies and sweet breads true

Is equivalent to:

[
{

"CategoryID": "1",
"CategoryName": "Beverages",
"Description": "Soft drinks, coffees & teas",
"In stock": "true"
by
{
"CategoryID": "2",
"CategoryName": "Condiments",
"Description”: "Sweet and savory sauces",
"In stock": "false"
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"CategoryID": "3",

"CategoryName": "Confections",
"Description”: "Candies and sweet breads",
"In stock": "true"

The dot ('.") character is used in the column header to show nesting. For example:

name carb cholesterol fiber minerals.ca minerals.fe protein sodium vitamins.a vitamins.c

1 Avocado Dip 2 5 0 0 0 1 210 0 0

Is equivalent to:

"name": "Avocado Dip",
"Carb": "2",
"cholesterol": "5",
Hfiber‘l: HOH,
"minerals": {

"ca": "O",

"fe": "O"
b
"protein" : "1",
"sodium": "210",
"vitamins": {

"a": "O",

"C". "O"

Any dots in JSON names are converted to hyphens ('-') on input.

254  HTML format
Easy Data Transform can output to tables in HTML format files. File extension ".html".
HTML (HyperText Markup Language) format is commonly used for creating web pages. If
you don't need the data to take up a whole page, you can just copy the <table> to

</table> part of the output.

For example:
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| CategorylD CategoryName Description In stock
11 Beverages Soft drinks, coffees & teas true
:2 g Condiments Sweet and savory sauces false
i33 Confections Candies and sweet breads true

Is output as:

<!DOCTYPE html>
<html>
<head>
<meta charset="UTF-8"/>
<title>C:\Users\andyb\Desktop\output.html</title>
<style>table, td, th{border:1px solid black;text-align:left;vertical-align:top;bord
</head>
<body>
<table>
<tbody>
<tr>
<th>CategoryID</th>
<th>CategoryName</th>
<th>Description</th>
<th>In stock</th>
</tr>
<tr>
<td>1</td>
<td>Beverages</td>
<td>Soft drinks, coffees &amp; teas</td>
<td>true</td>
</tr>
<tr>
<td>2</td>
<td>Condiments</td>
<td>Sweet and savory sauces</td>
<td>false</td>
</tr>
<tr>
<td>3</td>
<td>Confections</td>
<td>Candies and sweet breads</td>
<td>true</td>
</tr>
</tbody>
</table>
</body>
</html>

2.5.5 Markdown format

Easy Data Transform can output to tables in Markdown format files. File extension ".md".

Markdown format is commonly used as a human-friendly markup language, which can be
automatically translated to HTML.
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For example:

| CategorylD CategoryName Description In stock

11 Beverages Soft drinks, coffees & teas true

122 Condiments Sweet and savory sauces false

|

I

| 33 Confections Candies and sweet breads true
Is output as:
| CategoryID | CategoryName | Description | In stock |
| === [ === et | —========= |
|1 | Beverages | Soft drinks, coffees & teas | true
| 2 | Condiments | Sweet and savory sauces | false
| 3 | Confections | Candies and sweet breads | true

You can also use Markdown when you need a plain text version of your data, for example in
a code comment.

Note that not all Markdown implementations support tables. If your implementation does
not support tables, you may need to output to HTML instead.

2.5.6 TSV format

Easy Data Transform can input from and output to TSV format files. File extension ".tsv".

TSV (Tab Separated Value) format is commonly used for exchanging tabular data between
programs.

TSV is a type of delimited text file format. Values are separated by tab characters. Tabs are
not allowed within data values, so there is no need for quoting or escaping delimiters, as
with CSV files. This means that TSV files are generally a bit more compact and faster to read
and write than CSV files.

If you have a tab character in a value, Easy Data Transform will convert it to a space on
output.

2.5.7 vCard format

Easy Data Transform can input from and output to vCard format files. File extension ".vcf".

VCard format is commonly used as way of exchanging contact details between programs.
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Note that you need to change the column header names to the values expected by vCard
(using the Rename Cols transform).

For example:
N FN ORG TELTYPE=WORK,VOICE  ADR;TYPE=WORK, PREF
1 Gump;Forrest;Mr.; Forrest Gump Bubba Gump Shrimp Co. (111) 555-1212 100 Waters Edge;Baytown;

Is equivalent to:

BEGIN:VCARD

VERSION:3.0

N:Gump; Forrest;;Mr.;

FN:Forrest Gump

ORG:Bubba Gump Shrimp Co.

TEL; TYPE=WORK,VOICE: (111) 555-1212

ADR; TYPE=WORK, PREF:100 Waters Edge;Baytown;LA;30314;United States of America
END:VCARD

2.5.8 XML format

Easy Data Transform can input from and output to XML format files. File extension ".xml".

XML (Extensible Markup Language) format is commonly used for exchanging data between

programs.
For example:
| CategorylD CategoryMNarme Description In stock
11 Beverages Soft drinks, coffees & teas true
:2 2 Condiments Sweet and savory sauces false
i 33 Confections Candies and sweet breads true

Is equivalent to:

<?xml version="1.0" encoding="UTF-8"?>
<root>
<record>
<CategoryID>1</CategoryID>
<CategoryName>Beverages</CategoryName>
<Description>Soft drinks, coffees &amp; teas</Description>
<In-stock>true</In-stock>
</record>
<record>
<CategoryID>2</CategoryID>
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<CategoryName>Condiments</CategoryName>
<Description>Sweet and savory sauces</Description>
<In-stock>false</In-stock>

</record>

<record>
<CategoryID>3</CategoryID>
<CategoryName>Confections</CategoryName>
<Description>Candies and sweet breads</Description>
<In-stock>true</In-stock>

</record>

</root>

The dot ('.") character is used in the column header to show nesting. For example:

name carb cholesterol fiber minerals.ca minerals.fe protein sodium vitamins.a vitamins.c

1 Avocado Dip 2 5 0 0 0 1 210 0 0

Is equivalent to:

<?xml version="1.0" encoding="UTF-8"?>
<root>
<record>
<name>Avocado Dip</name>
<carb>2</carb>
<cholesterol>5</cholesterol>
<fiber>0</fiber>
<protein>1</protein>
<sodium>210</sodium>
<minerals>
<ca>0</ca>
<fe>0</fe>
</minerals>
<vitamins>
<a>0</a>
<c>0</c>
</vitamins>
</record>
</root>

Any dots in XML element names are converted to hyphens ('-') on input.

The underscore ('_") character is used at the start of a column header name to identify it as
an XML attribute. For example:

_name _carb _cholesterol _fiber minerals.ca minerals.fe _protein _sodium vitamins.a vitamins.c

1 Avocado Dip 2 5 0 0 0 1 210 0 0

Is equivalent to:

<?xml version="1.0" encoding="UTF-8"?>
<root>
<record carb="2" cholesterol="5" fiber="0" name="Avocado Dip" protein="1" sodium="2
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<minerals>
<ca>0</ca>
<fe>0</fe>
</minerals>
<vitamins>
<a>0</a>
<c>0</c>
</vitamins>
</record>
</root>

You are responsible for ensuring that the names of XML nodes and attributes are valid (e.g.
start with a letter or underscore and do not contain spaces).

2.5.9 YAML format

Easy Data Transform can output to YAML format files. File extension ".yaml".

YAML (YAML Ain't Markup Language) format is commonly used for exchanging data
between programs and for configuration files.

For example:
| CategorylD CategoryName Description In stock
11 Beverages Soft drinks, coffees & teas true
1212 Condiments Sweet and savory sauces false
|
|
|33 Confections Candies and sweet breads true
Is output as:

CategoryID: 1

CategoryName: Beverages

Description: Soft drinks, coffees & teas
In stock: true

CategoryID: 2

CategoryName: Condiments
Description: Sweet and savory sauces
In stock: false

CategoryID: 3
CategoryName: Confections
Description: Candies and sweet breads
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In stock: true

2.6 Headers

If the first row of an input is a header (i.e. one that describes the columns below) check has
header for that input in the Right pane.

KA
testl.csv ¢ 9

File: /Usersfandyb/Dropbox/testl.csv

Delimiter: Automatic

Encoding: Automatic

. & @

Ignore: Fir

simplify whitespace
ignore empty rows
watch file

Alias: testl

Comment:

22 cols x 64 rows

CllB||Z Show first 10 rows E

title |first name | last name | suffix | meal spe@

When you first read in a dataset Easy Data Transform will make a guess about whether the
first row is a header (it will assume it is a header if it contains no dates or numbers).

2.7 Connections

When you select an input or transform item and add a transform or output item,
connections are added automatically.

To select a connection

To select a connection either:

e Click on the connection; or

e Click and drag a box over any part of the connection. This may be easier than clicking the
connection when you are zoomed back.
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transactions.x...

Y, Filter

35 cols x 53.3k rows L\:P 35 cols x 53.3k rows

To delete a connection

To delete a connection:

e Select the connection.

¢ Select Edit>Delete (or click the Delete tool bar button).

Note that deleting a connection may unset column related parameters downstream, so

should generally be avoided where possible.

e If you want to change an input file, do it by selecting the input and clicking on "..." in the
Right pane, rather than disconnecting the input and connecting a new one.

e If you want to add a new transform between 2 already connected items, you can do it
without disconnecting (see below).

To add a transform to a connection

To add a transform between two already connected items:

e Select the connection.

e Choose the new transform from the Left pane or using the right click menu.

A

/" COVID-19-ge...

/[COVID-19-ge... Dedupe
11 cols x 14.7k rows i1l 20 s w 14.7% rars

To add a connection
To add a new connection between two existing items:
e Hover over the start item.
e Click the '+' that appears.
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transactions.x...

. 35 cols x 53.3k rows lick to connect from this item.

e Hover over the end item
e Click the '+' that appears.

transactions.x...

35 cols x 53.3k rows

lick to connect to this item.

Press the 'Esc' key or click away from an item to cancel adding the connection.

Note that the '+' will only appear if an additional connection is allowed. For example you
can't:

e Create a loop.

e Connect more than once from a transform.

e Connect more than once to an output.

2.8 Text
Whitespace (such as Space and Tab characters) and capitalization are always significant,

unless stated otherwise.

You can remove leading and trailing white space by checking trim whitespace in the Input
or using the Whitespace transform.

You can change the case using the Case transform.
2.9 Dates

Set the date formats you want to recognize in the Preferences window using the following
options:

Format Meaning
d The day as number without a leading zero (1 to 31)
[ The day as number with a leading zero (01 to 31)
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Format Meaning

ddd The abbreviated localized day name (e.g. ‘Mon' to 'Sun’). Uses the system locale
to localize the name.

cldclel The long localized day name (e.g. '‘Monday' to 'Sunday'). Uses the system locale

to localize the name.

The month as number without a leading zero (1 to 12).

The month as number with a leading zero (01 to 12)

MMM The abbreviated localized month name (e.g. 'Jan' to 'Dec’). Uses the system
locale to localize the name.

MM

. The long localized month name (e.g. 'January' to 'December'). Uses the system
locale to localize the name.

vy The year as two digit number (00 to 99).

yyyy The year as four digit number. If the year is negative, a minus sign is prepended
in addition.

For example:

e To support a date such as 31/1/2019 add a supported date format: d/M/yyyy
e To support a date such as 1-31-19 add a supported date format: M-d-yy

List the date formats in order of preference, with the most likely to be used first.

Note that dates with only two year digits, are treated as a date between 1900 and 1999. E.g.
"31/1/19" is interpreted in d-M-yy format as 31st January 1919.

Values that are in a recognized date format will be treated as dates in the Filter, If and Sort
transforms. Supporting large numbers of date formats will slow down these transforms.

You can change the format of dates using the Date Format transform and calculate the
difference between 2 dates using the Javascript transform.

2.10 Numbers

Easy Data Transform uses the locale set on your computer to decide what is a number. For
example, if your system locale is set to US or UK then "123.45" is a number and "123,45"
isn't, and vice versa if your system locale is Germany or France.

2.11 Meta Information

You can add meta information to input data using the Meta info field in the Right pane
when you select an input item. Set it to At start, At end or Every row, depending on where
you want the meta information to appear. Then click on the ... button to edit which
information you wish to show. The following placeholders are substituted by their actual
values at the time of input.
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Meta Information
$ (ComputerName)

S (CurrentDate)

S (CurrentDateTime)

S (DataColumns)

$ (DataRows)

S (DataValues)

S (FileCreatedDate)

S (FileCreatedDateTime)

S (FileName)

S (FilePath)

$(FileSizeBytes)

S (FileUpdatedDate)

Description Example

The name of the MyComputer
computer.

The current date, in  2020-08-18
ISO format.

The current datetime, 2020-08-

in ISO format. 18T18:00:00

The number of 10

columns in the

dataset (not including

meta data).

The number of row in 10,000

the dataset (not

including meta data).

The number of 100,000
columns x rows in the

dataset (not including

meta data).

The date the file was 2020-08-18
created, in ISO

format. Only available

for file input.

The datetime the file 2020-08-
was created, in ISO LELE 800300
format. Only available

for file input.

The name of the file, myfile.csv
including it's

extension. Only

available for file input.
The full path /Users/andy/Doc

(location) of the file. Uments /myfile.c

Only available for file

input.

The size of the filein 1,234,567
bytes. Only available

for file input.

The date the file was 2020-08-18
last updated, in ISO

format. Only available

for file input.
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Meta Information Description Example
% (FileUpdatedDateTime) The datetime the file 2020-08-

was last updated, in 18T18:00:00

ISO format. Only
available for file input.

% (UserName) The name of the user Andy
(from the USER or
USERNAME
environment
variable).

2.12 Column variables

Some transforms allow you to use the values of columns on the same row using column
variables. Column values can be referenced either:

e By column header name, e.g. $ (item cost) for the 'item cost' column; or
e By column index, e.g. s (1) for the first column.

Notes:

e The column name is case sensitive.

e Whitespace at the start or end of the column name is ignored.

e If multiple columns have the same name, the first from the left will be used.

e Reference by name takes priority over reference by index. For example, if there is a
column named "1" then s (1) will refer to that rather than the first column.

2.13 Regular expressions
Easy Data Transform allows the use of regular expressions in the replace, if and filter

transforms.

Regular expressions are a powerful way to match patterns in text (including text
representation of dates and numbers). For example, you can use a regular expression in the
Replace transform to swap first and last names:

Match type: Regex V)

Replace: (\Ww+)\s*[\w+)
With: 12, \1

Turns:

Easy Data Transform © 2020 Oryx Digital Ltd



Reference

Full name

1 John Smith
2 Mary Brown

3 Jill Jones

Into:

Full name

1 Smith, John
2 Brown, Mary

3 Jones, Jill

Regular expressions are far too big a topic to cover here. However there are many detailed
resources online, such as www.reqgular-expressions.info and regexr.com.

2.14 Batch processing

To apply the current transform template file to multiple input files select File>Batch
Process... . The Batch Process window will appear with a column for each input item and a
column for each output item. The Alias for each item is displayed in the column header.
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orders.csv

v

14 cols x 830 rows

Join output.json

v/ Ve

24 cols x 830 rows

24 cols x 830 rows

customers.csv

11 cols x 91 rows

®0®

Batch Process

Input columns can inglude wildcards and Exdgl sheet names:

E.g. /Users/andyb/Dbcuments/*.csv' or '[User§/andyb/Documents/data.xlsx[*]".
Qutput columns cannclude: {customers}, {ordiyrs}, {date}, {time}, {datetime}:
E.g. '/Users/andyb/Dpbcuments/{customers}_{datgtime}.csv'

Click 'Help' for more Hetails.

Add Remole Clear
Input alias=customers Input alias=orders Qutput alias=output (Overwrite)
1 pbox/northwind/customers.csv | .. indyb/Dropbox/northwind/*.csv | .. ip/merged/output_{orders}.json

wildcard Input file name

Note:

e All input and output items must have an alias.

e An output item can't have the same alias as another output or input item.
e Output items with Write mode=Disabled are not shown.

Click Add to add a new processing row.

Click Remove to remove the selected processing row(s).

Click Clear to remove all processing rows.

In the (pink) input column you can use * and ? wildcards for file name stems, file extensions
and Excel sheet names. E.g.:

Input Description
/Users/andy/Documents/*.csv || files with extension .csv in the Documents folder
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Input Description

/Users/andy/Documents/d?.csA|| the files with name 'd’ plus a single character in the
Documents folder

/Users/andy/Documents/data.p|| the sheets in data.xlsx in the Documents folder

/Users/andy/Documents/*.x1sp|| the sheets beginning with ‘data’ in all the .xslx files in
the the Documents folder

Note:

e If there is more than 1 input column that specifies multiple files or sheets, then an output
will be created for each possible permutation of input files/sheets in the row. E.g. 3 input
files from column 1 x 4 sheets from column 2 = 12 outputs to process.

e Excel sheet names are not case sensitive.

¢ You cannot use wildcards for folder names.

e Batch processing will ignore files in sub-folders.

In the (green) output column you can use the following variables to create your output file
name:

Output Meaning Example

variable

{<input alThe name of the input file being If input alias ‘orders' is using file
processed in the column with the
corresponding alias.

{date} Date processing was carried out in 2020_04_18
year_month_day format

{time} Time processing was carried out in15_21_56_599
hours_minutes_seconds_millisecon
ds format

tdatetime} pate/Time processing was carried 2020_04_18_15_21_56_599
outin

year_month_day_hours_minutes_s
econds_milliseconds format
format

Whether an ouput file is created, overwritten or appended to depends on the Write mode
of the output item.

Click Process to start processing the rows.
Click Stop to stop processing the rows.

Click Close to close the window.
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See also:
e Batch processing examples
e Command line arguments

2.15 Command line arguments

Easy Data Transform accepts the following command line arguments:

<file nanThe transform file to open at start-up.

—cli Close the application once any processing on the opened file is complete.

~file <algets the input or output file with the given alias to the location (path) specified.
Input Excel files should include the sheet name, e.g. file.xlsx[sheet]. Output
Excel files may optionally include a sheet name.

~new_winchg |oad the last opened .template file, even if open previous file at start-up is
checked in Preferences.

~verbose Qutput additional information to the terminal.

This allows you to process .transform files in batch mode, e.g.:

/Applications/EasyDataTransform.app/Contents/MacOS/EasyDataTransform /Users/andy/Docu
/Bpplications/EasyDataTransform.app/Contents/MacOS/EasyDataTransform /Users/andy/Docul

You can also use the Mac ‘open’' command:

open /Applications/EasyDataTransform.app --args /Users/andy/Documents/myfile\ 1.trans
open /Applications/EasyDataTransform.app --args /Users/andy/Documents/myfile2.transfo

But note that no command line output is shown if you use 'open’.

Put single quotes (') around any arguments with spaces or a backslash (\) in front of each
space (as shown in the examples above).

To do this on a schedule, call a script file from a scheduling program, such as launchd.

See also:
e Batch processing

2.16 .transform files

.transforms file are stored in a simple XML format. So you can edit them with a standard text
editor. However we recommend you make a copy first.

The results of transformations are not stored in the .transform file, and are recalculated
whenever you File>Open... the file.
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The contents of Input and Output files are not stored in the .transform file, only their
locations. These locations are stored as 'absolute’ locations, so you can move the .transform
file without changing the locations of the Input and Output files.

If you open a .transform file in a different location from that in which it was saved and it
can't find Input and Output files at the expected location it will look for them in the same
location relative to the old .transform file. This allows you to easily move .transform files to
different locations and computers if you keep the Input and Output files in the same relative
location (e.g. in the same folder as the .transform file). This even works between Windows
and Mac (and vice versa),

Example:

e mytransform.transformisin C:\Users\andy\Documents\ on Windows and uses Input
file MyData.csv in sub-folder Mybata (C:\Users\andy\Documents\Data\MyData.csv).

e mytransform.transform is moved to /Users/Bob/Documents/EDT on a Mac.

e When mytransform.transform is opened it will look for MyData.csv
in /Users/andy/Documents/Data.

e If it can't find that it will look for Mybata.csv in sub-folder MyData
(/Users/Bob/Documents/EDT/Data/MyData.csv).

If you paste in data From Clipboard this is stored in the .transform file. We don't
recommend you do this for large datasets as XML is not very efficient for storing large
amounts of data.

2.17 Keyboard shortcuts

Using keyboard shortcuts can improve your productivity. If you are using Easy Data
Transform a lot we suggest you find the time to learn at least some of them. The following
keyboard shortcuts are available for the Mac version of Easy Data Transform:

Key Shortcut Action

A Cmd+a Select all in Center
pane.

B - B Show the Batch

Process window.

F Ctrl+Cmd+F Toggle setting Right
pane item to
fullscreen. Only works
if 1 item in Right pane.

I OiDicd o Input From File.

Optiont+Shift+I Input From Clipboard.

N Lt s New .transform file.
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Key Shortcut Action
o) Cmd+0 Open .transform file.
01911000 Output To File.

S Cmd+3 Save .transform file.

Backspace Backspace Delete selected item(s)
in Center pane.

, Cmd+, Show Preferences
window.

= Cicli= Zoom Center pane so
all items fit.

+ Cmd++ Zoom Center pane in.

- S Zoom Center pane
out.

[ Option+| Move keyboard focus
to Center pane.

] Ry Move keyboard focus
to Right pane.

Left arrow Cmd+Left arrow Move Center pane
selection from item to
highest[1] item that
inputs to it.

Right arrow Crehitige 2emon Move Center pane
selection from item to
highest[1] item that it
outputs to.

Up arrow Cmd+Up arrow Move Center pane
selection from item to
highest[1] sibling[3].

Down arrow CRCHDONTE SO Move Center pane
selection from item to
lowest[2] sibling[3].

1.9 Cmd+l. . .Cmd+9 Select input item 1 to
9 (based on height in
Center pane).

Opitlonidl s o Opitlenis Select output item 1 to
9 (based on height in
Center pane).
F1 Fl Show help.

[1] Highest=nearest the top of the Center pane.
[2] Lowest=nearest the bottom of the Center pane.
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[3] Two items are considered siblings if they have inputs from the same item(s) or they both
have no inputs.

You can also use the keyboard to add transforms in the Center pane. Just select the item(s)
you want to add the transform to and start typing the name. Only eligible transform that
contain the typed letters will be displayed (spaces are ignored).

For example, to add the Rename Cols transform an existing Input item:

e select the input items

e type ren

e press the Return key

If you want to see a list of all the transform names, press the space key before you start
typing. You can use the Del or Backspace key to undo letters typed.

You can quickly change selection in the Center pane using arrow keys with the cmd key.

Left Arrow Up Arrow

Dedupe

JRemove Cols

4

4 ols x 14.7k rows 4 ls x 209 rows

Right Arrow

Pivot L/ Sort

2 ols x 210 rows 2 ls x 210 rows

Spread

v

104 cols x 209 rows

| Down Arrow |

If you are zoomed in you can scroll the Center pane by pressing the shift key and
dragging the canvas.
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3 How do I?
3.1 Add atransform between existing items

To add a new transform between existing items (e.g. between 2 already connected
transforms) see connections.

3.2 Add or remove a header

To add or remove a header just check or uncheck the has header checkbox for the
appropriate input item.

EA
testl.csv ¢

File: /Usersfandyb/Dropboxftestl.csv

Delimiter: Automatic

Encoding: Automatic

. & @

lgnore: Fir

=
W
n
=
]
o
=3
m
=

simplify whitespace
ignore empty rows
watch file

Alias: testl

Comment:

22 cols x 64 rows

ClB||Z Show first 10 rows H

@e first name last name suffix meal spe@

3.3 Change a connection

To change a connection see connections.
3.4 Change encoding

When Easy Data Transform inputs a text file (e.g. a CSV file) it will make a guess at the
encoding. You can explicitly set the encoding by selecting an input item and changing
Encoding from Automatic to one of the other encodings in the Right pane.

Easy Data Transform © 2020 Oryx Digital Ltd



How do I?

EA
testl.csv ¢

File: Jtrunk/help/data for screen caps/testl.csv

watch file
Delimiter: Automatic H
Encoding: Automatic E

Similarly you can also set the encoding of a text file output by selecting the output item and
changing Encoding in the Right pane.

output.csv @ E :

File: fUsersfandyb/output.csy

Delimiter: Comma (,) H

Encoding: UTF-8

3.5 Dedupe a dataset

If you want to remove duplicate entries from a dataset, use the Dedupe transform. For
example, to remove the 2 rows that have the same email from this dataset:

| First Last Email

|1J.A. Black jablack@gmail.com

'2 Paul White p.white@hotmail.com

3 Barry Green bareen@aol.com

4 Jane Brown Jb3423@gmail.com

5. Taupe taupeB89759@gmail.com

16 John Black jablack@gmail.com

7!B. Green bgreen@aocl.com

To get this dataset:
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First Last Email

1 JA. Black jablack@gmail.com
2 Paul White p.white@hotmail.com
3 Barry Green bgreen@aol.com

4 Jane Brown Jb3423@gmail.com

51. Taupe taupe89759@gmail.com

Drag the dataset file onto the Center pane of Easy Data Transform.

\/mailing xlsx[S...

3 cols x 7 rows

Select the dataset then click the Dedupe transform in the Left pane.

v;nailing.xls.x[s... Dedupe

v/

3cols x7 rows 3cobk x7 rows

Check Email in the Right pane to remove rows with duplicate emails.

Dedupe @I |5
E 'Q Filter columns

title
first name

]

(< J < J < |

last name

Only the first row with a particular email is kept. Use Sort if you want to change the order
before removing duplicates.

If you only want to remove rows with the same last name and same email, check both Email
and Last checkboxes.
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Note that de-duplicating columns takes account of whitespace and case. So you might need
to do Whitespace and Case transforms before the dedupe.

3.6 Find the difference between dates/datetimes

You can calculate the difference between two dates or datetimes using Date objects in the
Javascript transform.

There are 4 ways to create a Javascript Date object:

Date format Description
e DEe (yees, memth, ey, heuss, Specified date and time specified as numeric
minutes, seconds, milliseconds) .
parameters (January is month 0!).
Date and time specified as text.
pEty DEEE (uk) L LSOEenes) Milliseconds after 1st January 1970.
new Date () Current date and time.

new Date (text date)

Notes:

e A text date should be in yyyy-mm-dd format.

¢ A Date object always includes a time. If no time is set, then the time is assumed to be
midnight GMT.

¢ One and two digit years will be interpreted from 1900.

Examples

To calculate the number of milliseconds between a date in the 'date' column and 31st Dec

2000:

return new Date( $(date) ) - new Date( "2000-12-31" );
Or:

return new Date( $(date) ) - new Date( 2000, 11, 31 );

To calculate the difference between datetimes in the 'start' and 'end' columns in hours:
return ( new Date( $(end) ) - new Date( S$(start) ) ) / ( 60 * 60 * 1000 );
To calculate how many days ago 'date' occurred (rounded down):

return Math.floor( ( new Date() - new Date( $(date) ) ) / ( 24 * 60 * 60 * 1000 ) );

For more information see the Javascript documentation.
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3.7 Handle column name/order changes in inputs

If you have a .transform file that you want to run multiple input files through (perhaps with
a different input file each month, or as a batch process) you need to be aware of differences
in column name and column order in the input files.

To change the file being used by an input, select the input item and change the file location
in the Right pane (e,g, by clicking the "..." browse file button), rather the disconnecting the
input and connecting a new one. Otherwise column-related parameters downstream will be
reset.

Same columns in the same order, but with different names

Easy Data Transform references columns by their position (e.g. 3rd column from the left) not
their column name. So differences in column names (e.qg. first column is called "id" in input 1
and "UniquelD" in input 2) are not generally an issue. But you need to be careful if you are
using the Stack transform with Align columns by set to Header name, as this will reorder
columns by name. If you want to always output the same column names, regardless of the
input column names, you should use a Rename Cols transform to set the names.

Same columns with the same names, but in a different order

If columns are in different orders in different input files (e.g. the "id" column in the first
column in input 1 and the second column in input 2) you need to sort the input columns
into a standard order before applying other transforms. You can so this using the Stack
transform with Align columns by set to Header name. Stack your input under a dataset
with columns in the correct order. You can use a Filter to remove any unneeded rows after
the stacking. Note stacking by header name is sensitive to case and white space.
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ID title first last

1 dummy

o
F N

. header-order.c...

4 cols x 1 row

.'I . t.
J INpUt.csv

-

4 cols x 2 rows

title first last ID

1Mr  John Smith 001

2 Ms Jane Smith 002

Stack _ @2

Align columns by !

Comment:

Stack rows of all inputs. Orders by the
vertical (Y) position of the input

4 cols x 3 rows i

RB 7
ID title first last
1 dummy
2 001 Mr  John Smith
3 002 Ms  Jane Smith

Stack

4 cols x 3 rows

Filter

v v

4 cols x 2 rows

Ro):

Matching any -

Filter

@ ® keep ~

mn Op Value |
1D Yi|l=v dumnD

4 ¥

Comment:

Filter rows by text, date or numeric
values in selected columns.

4 cols x 2 rows

&<

ID title first last
1001 Mr John Smith
2002 Ms Jane Smith

Same columns with different names, in a different order
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Easy Data Transform can't handle this automatically. But you can create a new .transform
and use Reorder Cols and/or Rename Cols transforms to output to a new file with the
correct column names/ordering. You can then input this to the original .transform.

3.8 Handle large datasets

Large datasets (e.g. a million data points or more) can slow down processing. So we
recommend you add a sample transform straight after the input and set Rows to pass
through only the first 100 or so rows. Once you have completed all your transforms you can
then change the sample transform to pass through all rows.

3.9 Input a fixed width format file

Typically fixed width files have fixed width columns of text separated by spaces. They tend
to be associated with legacy systems, but are also used for large files where performance is
an issue (e.g. bioinformatics).

We don't currently explicitly support fixed width as a format. But you can input fixed width
format files into Easy Data Transform with a few extra steps. For example, for this file:

ID NAME PAYMENT

8904 John Black 12345.67
3999 Jane Brown 23456.78
7489 Zadlie Green 34567.89

Rename the file to have a .txt file extension (if it hasn't already) and drag it onto Easy Data
Transform. Set the delimiter to something that is not used in the text, e.g. caret (*), so that
it will import it as 1 column.

KA

payroll.txt @ i

File: /Usersfandyb/Dropbox/payroll.txt

Delimiter: Caret (%)

Encoding: Automatic

- & @

Ignore: First O row(s)
has header
trim whitespace
simplify whitespace
ignore empty rows
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Add a Javascript transform and use the Javascript substring () method to reconstruct the
column as delimited text.

Y payroll.txt Javascript

1 col % 3 rows 2 cols ¥ 3 rows

Javascript @) N

New column name: JS

Javascript:

AE?;; $(1).substring(0,4) + "A" + $(1).substring(11,22) + "A" +

wubstring{ﬂjﬁl;

Insert variable: <select> H Evaluate

|
Comment; i
Script your own custom transform in Javascript. :
2 cols x 3 rows
& &
ID NAME PAYMENT
1 8904  JohnBlack 12345.67 | 8904%John Black *12345.67

2 3999 Jane Brown  23456.78| 3999"Jane Brown ~23456.78

3 7489 Zadie Green 34567.89 ‘J489"Zadie Green*34567.89

3. Then add then a Split Col transform to break the delimited text into separate columns.

Easy Data Transform © 2020 Oryx Digital Ltd



How do I?

Y payroll.txt Javascript Split Col

5 cols x 3 rows

4

1 col x 3 rows 2 cols x 3 rows

Split Col QI - It
Colum |
Delimite
Ordering: Current H ‘
keep empty |
Min. new cols: 0 - |
Max. new cols: 100 »

Comment:

|
Split a column into multiple new columns. |
5 cols x 3 rows

ID NAME PAYMENT JS 1 | JS2 JsS3 |

1 8904 John Black  12345.67 8904"John Black 12345.67 | 8904 JohnBlack 12345.67 !
|
2 3999  Jane Brown 23456.78 3999%Jane Brown *23456.78| 3999 Jane Brown 23456.78 |,

3 7489 Zadie Green 34567.89 7489*Zadie Green*34567.89 9 Zadie Green 34567

You may then want to Whitespace the new columns and Remove Cols the first 2 columns.
You can remove unwanted rows using Filter.

We may add fixed width as an additional input type to make this easier, if enough people
are interested. Let us know.

3.10 Merge datasets

Easy Data Transform has two main options for merging two datasets. Stack and Join.
Stack datasets

If you want to merge the two datasets so they are one on top of another, use the Stack
transform. For example, to Stack these two datasets:
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MName ID DOB

John Black 001 01/07/1966
Paul White 002 11/03/1973

Barry Green 003 30/12/1977,

+

i Mame ID DOB
Jane Brown 004 03/11/198

! Jill Taupe 005 01/03/198

To get this dataset:

Name ID DOB
1£E"|—n Black 001 1966-07-01

2|Paul White 002 1973-03-11

3 @r}f Green 003 19??-12-_5’}[}/

4 Jfane Brown 004 1980-11-02\

Sli\llgTaupe 005 1981—03-[5}

Drag the two dataset files onto the Center pane of Easy Data Transform.

Easy Data Transform © 2020 Oryx Digital Ltd



How do I?

datasetl.xlsx|...

3 alsx Irows

dataset2.xIsx]...

3 cols x 2 rows

Select the two datasets using cmd+click then click the Stack transform in the Left pane.

datasetl.xlsx[...

3 wlsx Irows

Stack

3 cols x Srows

v

dataset2.xlsx|...

3 cols x 2 rows

The datasets are now stacked in the vertical order that the datasets are shown on the
screen. The top dataset is shown first. You can swap the the vertical positions of the
datasets to change the order in which they are stacked.

If you want to stack column n of the first dataset above column n of the second dataset, set
Align columns by to Column number.

If you want to stack columns by common header names (even if they aren't in the same
order), set Align columns by to Header name.

If you want to stack a large number of files you can do it by using batch processing to write
to an output item with Write Mode=Append.
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Join datasets

If you want to merge the two datasets side-by-side using a common (‘key') column, use the
Join transform. For example, to Join these two datasets:

ID Department Level
651 Engineering 1—\

MName D DOB
lé;m Black 001 1965-(]?&\

=

[t

003 Engineering 2

]

Paul White [802 1973-03-11
3 Barry Green @03 1977-12-30 I 3|004 Marketing 1

Jane Brown 004 1980-11-03 41002 Sales 2

5 Sales 3
Q0 J

ey

1]

IEKJilTaupe 005 1931-[!3:{})

By common ID value to get this dataset:

MName 1D DOB Department Level

1 dg}:n Black GGINIEIEE-D?—G Engineering 1 )

2|Paul White | 002 1973-03-11 Sales 2
3|Barry Green|{ 003 1977-12-3( Engineering 2

4|Jane Brown| 004 1980-11-03 Marketing 1

wTaupe @31981—{13—(}“5&95 3

Drag the two dataset files onto the Center pane of Easy Data Transform.

(¥, ]
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datasetl.xlsx|...

3 alsx Irows

dataset2.xIsx]...

3 cols x 2 rows

Select the two datasets using cmd+click then click the Join transform in the Left pane.

datasetl.xlsx|...

3 cols x5 rows

Join
V4
5 cols x5 rows

dataset2.xlsx|...

3 cols x5 rows

Set both Top key column and Bottom key column to the common (‘key') column.
The datasets are now joined side-by-side using the common column. The top dataset is
shown on the left. You can swap the the vertical positions of the datasets to change the

order in which they are joined.

If you just want to join row N of one dataset to row N of another dataset, you can use the
Row Num transform to create a common column in each dataset.

Set Include top non-matching rows and Include bottom non-matching rows depending
on what you want to do with top and bottom dataset rows for which there are no matches.
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Note that matching columns takes account of whitespace and case. So you might need to
do Whitespace and Case transforms before the join.

If you are merging numerical datasets you can also use an Interpolate transform.

Video: How to join Excel files

3.11 Move a .transform file

To move a .transform file to a different location on the same computer use File>Save As...
or Finder. You either leave the Input files at the original location or move them to the same
location relative to the .transform file (e.g. if they were in the same folder as the .transform
file before, move them to the same folder as new .transform file).

To move a .transform file to a different computer, move the Input files to the same location
relative to the .transform file (e.g. if they were in the same folder as the .transform file
before, move them to the same folder as new .transform file).

See also .transform files.
3.12 Output nested JSON or XML

You can use the dot (.") character in the column header to show nesting. For example:

name carb cholesterol fiber minerals.ca minerals.fe protein sodium vitamins.a vitamins.c

1 Avocado Dip 2 5 0 0 0 1 210 0 0

Is output to JSON as:

[
{

"name": "Avocado Dip",
"carb": "2",
"cholesterol": "5",
"fiber": "0",
"minerals": {

"Ca": HOH,

"fe": "O"
b
"protein": "1",
"sodium": "210",
"vitamins": {

"a": "o",

e OV
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And to XML as:

<?xml version="1.0" encoding="UTF-8"?>
<root>
<record>
<name>Avocado Dip</name>
<carb>2</carb>
<cholesterol>5</cholesterol>
<fiber>0</fiber>
<protein>1</protein>
<sodium>210</sodium>
<minerals>
<ca>0</ca>
<fe>0</fe>
</minerals>
<vitamins>
<a>0</a>
<c>0</c>
</vitamins>
</record>
</root>

For more details see:
e JSON format

e XML format

3.13 Output to Excel

To output results from a transform to an Excel .xIsx/.xls file:
e Select the transform item in the Center pane.
e Click To File at the bottom of the Left pane.
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- L ] Easy Data Transform v1.4.0 {free trial)
DBE 0 Q@ S # @ 7Hwor
Paw Col @ Stack @[5
Wum Format (B : | ) ) Align columns by:  Header name H
Pad @ Comment:
Pivot Q) Stack rows of all inputs. Orders by the vertical (Y] position
_ of the Input datasets.
Remove Cols (7))
’ ) : : Shiw firs1 10 rews
Aenamecol  (7) G|® 2 L -]
Rpoedar Coly @ tithe: first rama  last name suffix  display nama
F— @ . 1 M Andrew  Adams Mr Andrew Adarns.
testl.csv ik ik
P—— @ i v 2 Mirs  Mikki Adams Mrs Hildki Adams:
Sampin @ e 1 Ms  Rose  Atwel s Rose Atwel
Sort o] 4 Mr  Colin Ayer Mr Colin Ayer
St Cal & Stack 5 Mz Michelle Blaire Mrs Michalle Blaire
H-"‘ .
Foread 0] » I3 eols x BE rows & Mr Simon Blaire Mr Simon Blaire
@ T owr  Albart  Brown Mr Albert Brawn
Btamp @ 8 Mre  Cynthia  Brown Mrs Cynthia Brown
P test2.csv
Srats (2 v 9 Miss Jang Brown Mrs Jang Brown
Substiute -@ 42 cols x LA rows
= W Mf  David  Burgess Mr David Burgess
Summar 7
X W Last 72 rows not shown
3

Tortal
Tranapaes @

Teifm

[ Email us questions/fesdback

Excel file (*r
- Excel file (%xis)

P £ ok ke )

Note that Excel files are typically limited to 1,048,576 rows and 16,384 columns.
3.14 Perform the same transforms on many files

You can perform the same set of transforms on multiple inputs in one operation using batch
processing or command line arguments.

Example 1
To convert a folder full of .csv files to .json files:

1. Select File>New to create a new transform template file

2. Drag one of the .csv files onto the Center pane. Ensure the options (encoding etc) are
correct in the Right pane.

3. Click on the To File button at the bottom of the Left pane and set the location of a .json
file to create. Ensure the options (encoding etc) are correct in the Right pane.
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testl.csv output.json

v v

22 cols x 64 rows 22 cols x 64 rows

4. Select File>Batch Process.
5. In the Batch Process window change the .csv file name to *.csv and output.json to
output {testl}.json.

- ® Batch Process

Input columns can include wildcards and Excel sheet names:

E.g. '/Users/andyb/Documents/*csv' or 'fUsers/andyb/Documents/data.xIsx[*]"

Qutput columns can include: {test1}, {date}, {time}, {datetime}: r
E.g. '/Users/andyb/Documents/{test1}_{datetime}.csv'

Click "Help' for more details.

Add Remove Clear

Input alias=test1 Qutput alias=output (Overwrite)

1 fUsersfandyb/Desktop/=csv jUsers{andybfoutput_{test‘l}ljscn

Process Stop

6. Press the Process button. A .json file will now be created for each .csv file in the folder.

If you want to process input files from another folder then click Add to add a new row and
change the test1 input folder.

Example 2
Merge multiple .csv files into a single .csv file:

7. Select File>New to create a new transform template file

8. Drag one of the .csv files onto the Center pane. Ensure the options (encoding etc) are
correct in the Right pane.

Easy Data Transform © 2020 Oryx Digital Ltd



How do I?

9. Click on the To File button at the bottom of the Left pane and set the location of a
merged.csv file to create, in a different folder to the input .csv files. Ensure the options
(encoding etc) are correct.

testl.csv

J merged.csv

v

22 cols x 64 rows 22 cols x 64 rows

4. Set Write Mode to Append in the Right pane.

KA
"}

merged.csv ©)

File: /Usersfandyb/Desktop/merged/merged.csv

Delimiter: Comma (,)

(O O

Encoding: UTF-8

Values as: Modes
Byte Order Mark

Write mode

Alias: merged

5. Select File>Batch Process.
6. In the Batch Process window change the input .csv file name to *.csv.
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@ ® Batch Process

Input columns can include wildcards and Excel sheet names:

E.g. ‘/Users/andyb/Documents/*.csv' or '/Users/andyb/Documents/data.xlsx[*]"
Output columns can include: {test1}, {date}, {time}, {datetime}:

E.g. ‘/Users/andyb/Documents/{test1}_{datetime}.csv"

Click 'Help' for more details.

Add Remove Clear

Input alias=test1 Output alias=merged (Append)

1 [Usersfandyb/Desktop/*.csv - | [Usersfandyb/Desktop/merged/merged.csv

Process Stop

7. Press the Process button. A single merged. csv file will now be created that contains a
concatenation of all the other .csv files. If merged.csv already exists, you may need to
delete it first.

If the headers are different orders in different .csv files, then you can Stack by header name
to get a consistent column order before outputting.

colum n-order....

S cols x 1 rew

Stack

merged.csv
J g

27 cols x6S rows 27 @ls x 65 rows

testl.csv

22 cobs x Bdrows
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Stack

A
]

Align columns by( Header name ) H

Comment:
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Support

4.1 Contact support

If you have any questions or suggestions, please contact us at
support@easydatatransform.com .

4.2 Report abug

Please report any bugs you find to support@easydatatransform.com and we will attempt to
fix them. Please include:

e a description of the bug

e your operating system (e.g. Windows 10)

e the version of Easy Data Transform (from Help>About)

e a step-by-step description of how we can reproduce the problem
e a screen capture can often be helpful

The step-by-step description is particularly important - if we can't reproduce your problem,
then we probably won't be able to fix it.
4.3 Request an enhancement

We are always very interested to hear your suggestions on how the software can be
improved. Please email us at support@easydatatransform.com .
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